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Enterprise Architect builds on top of its already exceptional
code generation, diagramming and design capabilities with a
complete suite of tools to build, debug, visualize, record,
test, profile and otherwise construct and verify software
applications. The toolset 1s intimately connected to the
modeling and design capabilities and provides a unique and
practical means of constructing software from a model and
keeping model and code synchronized.

Enterprise Architect helps you define 'Analyzer Scripts'
linked to Model Packages that describe how an application
will be compiled, which debugger to use and other related
information such as simulation commands. The Analyzer
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Script 1s the core configuration item that links your code to
the build, debug, test, profiling and deployment capabilities
within Enterprise Architect.

As a measure of how competent the toolset is, it should be
noted that Enterprise Architect is in fact built, debugged,
profiled, tested and otherwise constructed fully within the
Enterprise Architect development environment. Many of the
advanced debugging tools such as Action Points have been
developed to solve problems inherent in the construction of
large and complex software applications (such as Enterprise
Architect) and are routinely used on a daily basis by the
Sparx Systems development team.

It 1s recommended that new users take the time to fully
understand the use of the Analyzer Scripts and how they tie
the model to the code, to the compilers and to other tools
necessary for building software.

Integrating Model and Code

Model Driven Engineering 1s a modern approach to software
development and promises greater productivity and higher
quality code, resulting in systems getting to market faster
and with fewer faults. What makes this approach compelling
is the ability for the architecture and the design of a system
to be described and maintained in a model, and then
generated to programming code and schemas that can be
synchronized with and visualized within the model.

Enterprise Architect's Model Driven Development
Environment (MDDE) supports this approach and provides
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a set of flexible tools to increase productivity and reduce
errors. These include the ability to define the architecture
and design in models, generate code from these models,
synchronize the code with the models and maintain the code
in sophisticated code editors. Source code or binaries can
also be imported, and users can record and document
pre-existing or recently developed code. The Analyzer
Script tool helps you to describe how to build, debug, test
and deploy an application.

Facility Description
Model Model Driven Development provides a
Driven more robust, accessible and faster

Development = development cycle than traditional
coding-driven cycles.

A well constructed model, intimately
linked with source code build, run,
debug, test and deploy capabilities
provides a rich, easily navigated and
easily understood target architecture.
Traceability, linkage to Use Cases,
Components and other model artifacts,
plus the ability to readily record and
document pre-existing or recently
developed code, make Enterprise
Architect's development environment
uniquely effective.

Enterprise Architect incorporates industry
standard intelligent editing, debuggers
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and modeling languages.

The Model The MDDE provides tools to design,
Driven visualize, build and debug an application:

Development ., UML technologies and tools to model
Environment software

(MDDE) . Code generation tools to

generate/reverse engineer source code

. Tools to import source code and
binaries

. Code editors that support different
programming languages
. Intelli-sense to aid coding

. Analyzer scripts that enable a user to
describe how to build, debug, test and
deploy the application

. Integration with compilers such as
Java, .Net, Microsoft C++

. Debugging capabilities for Java, .NET,
Microsoft C++ and others

. Advanced visualization, recording,
inspection, testing and profiling
capabilities

phpp = nelw CEBCGPAppointmentDemo
{

4 2 of 2 ™ CBCGPAppointmentDemonCBCGPAppointmentDemo(COleDateTime8: dtStart,
COleDateTimed& dtFinish, CString &t strText, COLORREF clrBackground, COLORREF
clrfForeground, COLORREF clrDuration)

RGE (165, 222, 89),

CLE_DEFAULT,

RGE (128, 0O, 128)
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Analyzer Scripts

Analyzer Scripts are used by the Execution Analyzer. You
do not need to worry about creating these. They are not the
same type of script as JavaScript or PHP, but are managed
using a familiar user interface - a tree view - and you can
quickly locate the feature to change. Analyzer Scripts can be
shared by users of a community model and are easily
imported and exported as XML files.

» Tomcat

= Bfu";u.m Build Execute Command as: Batch File

i Clean javac.exe -g -verbose -cp %CLASSPATH%; %APACHE_HOME%\1lib‘servlet-api.jar" -d clia
B Test IF ERRORLEVEL 1 GOTO BUILD_ENC

i Test cd

i Testpoints jar cvf servlet.war *

- Debug :BUILD_END

- Platform

- Runtime Host

- Tracepoints

- Workbench

El- Source Contro

- Merge

- Changes

- Histary

- Commit

- Working Copy

- Repository 4 »
El- Code Miner

i Service
i Libraries
El- Private Option: Parse Output: Java SDK

Default Directory:  %VEA%)\] ava\Tomcat\HelloServiet\WEB-INF

.. RUN Remote host: eg: mypcOL: 7777

- Deploy Deploy after build
- Recording

- Simulation

- Run Javascript

Close

A single project can have multiple configurations and these
can be found grouped together in the Analyzer window.

c) Sparx Systems age 100
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Execution Analyzer v q

- -9 Bagd i @
4 09 Example Model.Analysis and Business Modeling.DMM Examples.Package]
[#] DMM.Affordability calculation.Java
] DM .Application risk score model Java
Ol DMM.Bureau call type table.Java
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[l [ DMM.Installment calculation.Java
Ol DMN.Post-bureau risk categery tableJava
[ [ DMM.Pre-bureau risk category tableJava
Ol g DMN.Routing rules.Java
4 09 Example Model.Model Simulation.Executable State Machine.Entering A State
Ol Simulation.5tateMachine Artifact1.C++ Microsoft Native
O [ Simulation.StateMachine.EnteringAStateSimulation JavaScript.Scripting
i» 9 Example Model.Model Simulation.Executable State Machine.Entry and Exit Points (Connecti
I» 9 Example Model.Model Simulation.Executable State Machine.Example: CD Player
i» 9 Example Model.Model Simulation.Executable State Machine.Example: Regular Expression P:
I» 09 Example Model.Model Simulation.Executable State Machine.ForkMJoin

i» 9 Example Model.Model Simulation.Executable State Machine.History Pseudostate

Each Analyzer Script is defined for a Package, so projects
can co-exist quite happily. In many organizations, the
procedures to manage systems are distributed, and vary
from individual to individual and group to group. Analyzer
Scripts in an Enterprise Architect model can provide some
peace of mind to these organizations, by trusting a single,
shared and accountable procedure for building and
deploying any variety of configurations. All aspects of a
script are optional. You can, for instance, debug without
one; however, with a few lines they can enable these useful
features:

. Building

. Testing

. Debugging
. Recording

c) Sparx Systems age 11o
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. Execution
. Deployment
. Simulation

Remote Script Execution

Various Analyzer Script sections such as Build and Run,
provide a 'Remote Host' field. This field 1s used to describe
the computer on which the script should run. In order to use
this feature, the Sparx Satellite service must be running on
the machine. The format of this field is hostname:port,
where hostname 1s the IP address or network name of a
Windows or Linux machine and port 1s the Port number that
the Satellite service is listening on. The primary goal of this
feature is to allow a user of Enterprise Architect running on
Linux to execute commands native to Linux.

c) Sparx Systems age 120
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Managing Analyzer Scripts

The Execution Analyzer window enables you to manage all
Analyzer scripts in the model. You can use the window
toolbar buttons or script context menu options to control
script tasks. Scripts are listed by Package; the list only
shows Packages that have Analyzer scripts defined against
them. Each user can set their own active script, independent
of other users of the same model; one user activating a script
does not impact the currently active scripts for other users or
affect the scripts available to them. The active script governs
the behavior of the Execution Analyzer; when choosing the
build command from a menu, for example, or clicking the
Debug button on a toolbar.

There can be a lot of Packages with scripts listed in the
window. To help you locate and isolate a particular
Package, use the 'Filter Packages' context menu options,
described in the Context Menu Options table 1n this topic.

Note that when a script is highlighted in the Execution
Analyzer window, the window context menu options and
Execution Analyzer window toolbar buttons will operate on
the highlighted script. However, Execution Analyzer options
on any ribbon or floating toolbar, or in the Debugger (which
are not on the window) will always use the default Analyzer
script - the one that has the selected checkbox beside the
script name.

Access
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Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts
Toolbar Options
Toolbar Action
Button
¥ - Quick access to the Analyzer core

windows such as Call Stack or Local
Variables, plus the power features:

. Profiling
. Recording
. Testpoints
. Simulation

- Create and edit a new Analyzer Script for
the selected Package, under either Linux
or Windows™,

* Export Scripts.

c) Sparx Systems age 140
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Export one or more Analyzer Scripts to
an XML file, which can be used to import
the scripts into another model.

The 'Execution Analyzer: Export' dialog
displays from which you select the script
or scripts to export, followed by a prompt
for the target file name and location.

Import Scripts.

Import one or more Analyzer Scripts into
the current model from a previously
exported XML file.

The 'Find Package' dialog displays, on
which you select the Package into which
to import the scripts, followed by a
prompt for the source filename and
location.

Execute the 'Build' command of the
active script.

Cancel the 'Build' command currently in
progress.

Execute the 'Run' command of the active
script.

Execute the 'Test' command of the active
script.
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A Execute the 'Deploy' command of the
active script.

Context Menu Options

Right-click on the required script or Package to display the
context menus.

Option Action
Add New Add a new script to the selected Package.
Script The Execution Analyzer window

displays, showing the 'Build' page.

Paste Script  Paste a copied script from the Enterprise
Architect clipboard into the selected
Package.

You can paste the copied script several
times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and
overtype the script name.

Export Export scripts from the selected Package.

Scripts The 'Execution Analyzer: Export' dialog
displays, from which you select the script
or scripts to export, followed by a prompt
for the target filename and location.

c) Sparx Systems age 160
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Import scripts from a . XML file into the
selected Package.

A prompt displays for the source
filename and location.

Displays a submenu of options to:

. Enter the Package path against which
to filter the list of Packages - when you
select the 'Filter Packages' option, a
prompt displays to accept the
currently-selected Package path, or you
can remove the end elements of the
path to specify a larger set of Packages;
when you click on the OK button the
first Package in the list 1s expanded to
list the scripts i1t contains

. Switch between showing the full list of
Packages and hiding the full list of
Packages to expose only the
currently-selected Package

. Remove the currently-active filter to
show the full list of Packages

Highlight the selected Package in the
Browser window.

Display the Browser window, which is
now expanded to show the highlighted
Package.
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Build Execute the 'Build' command of the
selected script.

Clean Execute the 'Clean' command of the
selected script.

Rebuild Execute the 'Clean' and 'Build' commands
of the selected script.

Debug Execute the 'Debug' command of the
selected script.

Run Execute the 'Run' command of the
selected script.

Test Execute the 'Test' command of the
selected script.

Deploy Execute the 'Deploy' command of the
selected script.

Merge Execute the 'Merge' source control
command of the selected script.

Changes Execute the 'Changes' source control
command of the selected script.

History Execute the 'History' source control

(c) Sparx Systems 2023 Page 18 of 237
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command of the selected script.

Commit Execute the 'Commit' source control
command of the selected script.

Working Execute the "Working Copy' source
Copy control command of the selected script.
Repository Execute the 'Repository' source control

command of the selected script.

Run Execute the 'Run JavaScript' command of

JavaScript the selected script. When this option is
selected, a job is created in the Job Queue
window.

Job Queue

i x 1 2

MName Task Status E
=+ Actionpoint tests...  JavaScript Active

1

Execution Analyzer | Job Queue

Start Start the simulation referenced by the
Simulation 'Analyzer Script Simulation' page.
Run Start a simulation of the selected
Executable Executable Statemachine Artifact.

c) Sparx Systems age 190
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Statemachine

Edit Open the selected script in the 'Analyzer
Scripts Editor'".

Copy Copy the selected script to the Enterprise
Architect clipboard.

Paste Paste the most-recently copied script to
the same Package as the selected script.

You can paste the copied script several
times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and
overtype the script name.

Delete Delete the selected script; there is no
prompt for confirmation.

To delete a Package from the Execution
Analyzer window, delete the scripts from
the Package. When the last script is
deleted, the Package is no longer listed.

Package Set the selected script as the default script
Default for the Package.

The icon to the left of the script changes
color; any previous Package default
reverts to normal.

c) Sparx Systems age 200
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Analyzer Script Editor

The Analyzer Script Editor has a straightforward user
interface, with a tree view of the scripts on the left enabling
casy navigation of the script groups, and a content view on
the right in which you define and configure the scripts.

» Tomcat VO
g B;u”d . Build Execute Command as: Batch File
- Build
.. Clean javac.exe -g -verbose -cp %CLASSPATH%; %APACHE_HOME%\1ib‘servlet-api.jar" -d clia
B Test IF ERRORLEVEL 1 GOTO EUILD_END
fTest cd
.. Testpoints jar cvf servlet.war *
E- Debug :BUILD_END
Platform
Runtime Host
-Tracepoints
Workbench
El- Source Contro
Merg

| pm:ti ?;isom E:r::ou;;euct:ory: J;a SD; ava\Tomcat\HelloServet\WEB-
S
Access
From the 'Execution Analyzer' window, either:
. Double-click on a script to edit it or
. Right-click on a script and select the 'Edit' option
Ribbon Develop > Source Code > Execution

Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

c) Sparx Systems age 220
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Keyboard Shift+F12
Shortcuts

Execution Analyzer Scripts

Task - Page  Action

Build - Build = Enter the script or command to build the
application. This can be an Apache Ant
or Visual Studio command, but can also
be tailored depending on your
development environment. Note:
Remember to select a parser to get
directly to the source code in the event of
any errors. The parser field is on the same
page and offers support for many
languages.

Build - Clean = Enter the script or command to clean the
previous build. This is the command line
you would normally i1ssue to build your
system. This can be an Apache Ant or
Visual Studio command depending on
your development environment.

Test - Test Enter the script or command to test the
application. This is typically where an

(c) Sparx Systems 2023 Page 23 of 237
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Test -
Testpoints

Debug -
Platform

Debug -
Tracepoints

Debug -
Workbench

Debug -
Runtime
Host
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nUnit or jUnit invocation might be
configured, but it just as easily could be
any procedure or program.

Specify where the output from a
Testpoint run 1s sent.

Specify the debugging platform, the
application to be debugged, and the mode
of debugging (attach to process or run).

Specify where the output from
Tracepoints encountered during a debug
session are sent.

For .NET projects, the assembly to load.
Not required for Java.

Allows Enterprise Architect to launch the
program to be debugged using a
command line. This is typically used for
Mono or Java programs that use a socket
transport for debugging. This command i1s
executed prior to the Debugger being run.
The Port number specified in this
command should be the same value
passed to the 'Port' option in the Debug
page. When the Debugger starts, it will
attempt to connect to the runtime on this
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Port. If successful, it then binds any
breakpoints and resumes the
program,which it assumes to be
suspended. Java and Mono both have
command line options on the debugging
transport to initially suspend the process
till the Debugger connects.

Source This is the script that executes when the
Control - 'Merge' option is chosen from the context
Merge menu of an Analyzer Script. It provides a

place to run a program or shell script to
examine the differences between source

files.
Source This is the script that executes when the
Control - 'Changes' option is chosen from the
Changes context menu of an Analyzer Script. It

provides a place to run a source control
program such as 'svn' that might list
current changes to a source control

repository.
Source This is the script that executes when the
Control - 'History' option 1s chosen from the
History context menu of an Analyzer Script. It

provides a place to run a source control
program such as 'svn' that might list a
history of changes to a source control

(c) Sparx Systems 2023 Page 25 of 237
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repository.
Source This is the script that executes when the
Control - 'Commit' option is chosen from the
Commit context menu of an Analyzer Script. It

provides a place to run a source control
program such as 'svn' that might commit
changes to a source control Working

Copy.
Source This is the script that executes when the
Control - 'Working Copy' option 1s chosen from the
Working context menu of an Analyzer Script. It
Copy provides a place to run a source control

program such as 'svn' to perform actions
on the current working copy of a source

repository.
Source This 1s the script that executes when the
Control - 'Repository' option is chosen from the
Repository context menu of an Analyzer Script. It

provides a place to run a source control
program such as 'svn' to perform actions
on a source repository.

Code Miner - | In this section you can choose how the

Service Code Miner service operates. You can
choose either a remote server or to use
libraries locally.
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Code Miner - = This section provides a place for the

Libraries management of Code Miner libraries.
Here, you can create libraries based on a
project codebase or repository. Code
Miner libraries created here can be
searched using mFQL queries. Queries
composed in mFQL can be used to search
one or more libraries in a single

operation.
Private This 1s where the IP address and Port of
Options - Enterprise Architect Satellite services for
Services Linux and Windows are configured.

These services provide enterprise-wide
support for system management functions
and remote debugging scenarios.

Job Settings = Most of the commands contained in an
Analyzer Script are executed as jobs in
the Job Queue. Each script can be
configured to post a notification to a
specified user group when a specified job
completes. The 'Job Settings' group
provides the 'Notifications' option, which
displays the fields through which you
enter the job 1dentity as part of the text to
display to the members of the Model
Mail user group, and the user group
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name.

Build
Test
Debug

| Post on completion

Job Identity
Source Control

Code Miner
Private Options A friendly mnemonic for eazy identification in posts
Job Settings

Motifications User Group

Run

[ S S g

. nPlost on completion - select this
checkbox to enable the other two fields

. Job Identity - Type in the text to
display, which should also 1dentify the
job; for example: 'Installers Completed'

. User Group - Click on the drop-down
arrow and select the appropriate Model
Mail user group

Run In this section you can create and store a

JavaScript JavaScript that you can execute by
selecting the 'Run JavaScript' option from
the context menu of an Analyzer Script.

‘Warkbench

4 Source Contral Zli :f { theElewent != null && theElement.ChjectType == EA.CbjectType.otElement )

Merge a1
Changes
Histary T ¥e d
Commit ( }
Warking Copy i o = !
Repository o v

Code Miner .
Service // kDD A METHOD
Libraries "

Private Optio 2 er.
Services o rect

Job Settings e
Notifica et ho

Ru ddNeu( ]

c) Sparx Systems age 280
(c)S S 2023 P 28 of 237



Build and Debug

13 November, 2023

Clean

Rebuild

Run Javascript

Edit

Copy

Delete

Filter Packages
Package Default

Help

When this option 1s selected, a job 1s
created in the Job Queue window.

Job Queue

m $ + X |1 3

MName Task Status
= Actionpoint tests...  JavaScript Active
l

Execution Analyzer | Job Queue

(c) Sparx Systems 2023
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Run Enter a command to run an application.

Deploy Enter a script or command to deploy the
project. Build your jar file. Deploy to
your device, an emulator or Tomcat
server. Publish a web site. Its up to you.

Recording Does your Sequence diagram resemble
the national grid? Reduce the clutter with
filters. Filters define exclusion zones in
your code base that can cut down
dramatically on any 'noise' that is being
recorded. Even accurate noise 1s not
always helpful.

Simulation Complete the configuration for
Simulation Control.

c) Sparx Systems age 300
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Build Scripts

The 'Build' page enables you to enter commands to build
your project. You can use Enterprise Architect Local Paths
and environment variables in composing your command
line(s). You can choose to create your own build script,
entering various shell commands. You can also choose to
simply run an external program or batch file such as an Ant
script.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Build > Build' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Build'

page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Build
Context
Menu

Keyboard Ctrl+Shift+F12
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Shortcuts

Build

Write your script in this text box, using the windows shell
commands; the format and content of this section depends
on the actual compiler you use to build your project. If the
path or arguments contain spaces, surround them with
quotes; for example: "c:\program files
(x86)\java\bin\javac.exe".

Here are some examples:
Visual Studio:

"C:\Program Files (x86)\Microsoft Visual Studio
9.0\Common7\IDE\devenv.com" /Rebuild Debug
RentalSystem.sln

Visual Studio using a Local Path:
"%VsCompPath%)\devenv.exe" /build Debug Subway.sln
Java:

C:\Program Files (x86)\Java\jdk1.6.0 22\bin\javac.exe"
-g -cp "%classpath%;." %r*.java
Java using a Local Path:

"0JAVA%)\bin\javac.exe" -g -cp "%classpath%;."
%r*.java

Wildcard Java Builds (%r) - Source files in sub-folders
can be built using the %r token. The token has the effect of
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causing a recursive execution of the same command on any
files in all sub-folders, as shown in the example.

Execute Command as

Click on the drop down arrow and select the mode of
executing the script:

. Batch File - Use this option to execute a shell script in a
system command window; environment variables can be
accessed by commands in this script

. Process - Use this option to execute the command as a
single program; the command should specify the path to
the program, plus any command line arguments

Default Directory
Browse for or type in the default directory path in which the
build script process will run.

Parse Output

Click on the drop-down arrow and select a method for
automatically parsing the compiler output.

If you select this option, output from the script 1s logged in
the System Output window; Enterprise Architect parses the
output according to the syntax you specify.
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Remote Host

Type 1n the ID of the remote host system and its port; for
example, mypc01:7777.

If you set this property to #SYSTEMHOST#, the script is
sent to the Windows Satellite Service when running on
Windows, and the Linux Satellite Service when running
under Wine. The service IDs and Ports are defined in the

'Private Options - Services' section of the Analyzer Scripts
Editor.

Deploy after Build

Check this box to cause the Deploy script to be executed
immediately after this Build script completes.

Notes

To execute the Build script, click on the Package in the
Browser window and either:

. Right-click on any Toolbar and select 'Analyzer Toolbars |
Build', or

. Press Ctrl+Shift+F12 or

. Select the 'Execute > Source > Build > Build' ribbon
option
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Cleanup Script

Incremental builds are the practice of only building those
assets that have changed in some way. There are times,
however, when there 1s cause to build everything again from
scratch. This command is used for those occasions, to
remove the binaries and intermediary files associated with a
particular build or configuration. The project can then be
rebuilt. When you execute the 'Rebuild' menu option on a
script, the command(s) you specify in this field are
executed, followed immediately by the 'Build' command
from the same Analyzer script. Some compilers have
options do this for you. Visual studio for example has the
"/clean" command line switch.

This 1s an example script: devenv.com /Clean Debug
MyProject.sln

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Build > Clean' page or

. Click on ¥ - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Clean'

page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
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Execute > Source > Build > Clean

Analyzer Clean
Context
Menu

Keyboard Shift+F12

Shortcuts
Aspects
Aspect Detail
Clean Enter the command to be executed when
you select 'Clean' from the script context
menu.
Execute Click on the drop-down arrow and select

Command as | the appropriate option:

. Batch File - Use this option to create a
shell script that 1s executed in a system
command window; environment
variables can be accessed by
commands 1in this script

. Process - Use this option to run a single
program - the command should specify
the path to the program, plus any
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command line arguments; - if the path
or arguments contain spaces, surround
them with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"

Default Defaults to the value entered for the

Directory Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.

Parse Output = Click on the drop-down arrow and select
a method for automatically parsing the
compiler output.

If you select this option, output from the
script 1s logged in the System Output
window; Enterprise Architect parses the
output according to the syntax you
specify.

Remote Host = Type in the ID of the remote host system
and its port; for example, mypc01:7777.

If you set this property to
#SYSTEMHOST#, the script is sent to
the Windows Satellite Service when
running on Windows, and the Linux
Satellite Service when running under
Wine. The service IDs and Ports are
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defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.
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Test Scripts

These sections explain how to configure the 'Test' page of
an Analyzer Script for performing unit testing on your code.
Most users will apply this to NUnit and JUnit test scenarios.
Enterprise Architect accepts the output from these systems
and can automatically add to and manage each unit test case
history. To view the case history, you would select the test
case Class element and press Alt+2 > Testing.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Test > Test' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the '"Test > Test'

page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Test
Context

Menu

Keyboard Shift+F12
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Shortcuts

Actions

Test Type the Test command or script in this
field. For example:

. NUnit - "C:\Program
Files\NUnit\bin\nunit-console.exe"
"bin\debug\Calculator.exe"

. JUnit - java junit.textui. Testrunner %N

The command listed 1n this field 1s
executed as if from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
surrounded in quotes.

If you include the string %N 1in your test
script it is replaced by the fully
namespace-qualified name of the
currently selected Class when the script is
executed.

Execute Click on the drop-down arrow and select
Command the appropriate option:

As . Batch File - Use this option to create a
shell script that 1s executed in a system
command window; environment
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variables can be accessed by
commands in this script

. Process - Use this option to run a single
program - the command should specify
the path to the program, plus any
command line arguments; if the path or
arguments contain spaces, surround the
path with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"

Default Defaults to the value entered for the
Directory Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.

Parse When a parser is selected, output of nUnit
Output and jUnit tests can be parsed, saved and
managed from the model; (Alt+2 >
Testing). Be aware that output 1s only
captured when a parser is selected.

Remote Host Type in the ID of the remote host system
and its port; for example, mypc01:7777.

If you set this property to
#SYSTEMHOST#, the script 1s sent to
the Windows Satellite Service when
running on Windows, and the Linux
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Satellite Service when running under
Wine. The service IDs and Ports are
defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.

Build First Select to ensure that the Package is
compiled each time you run the test.
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Testpoints Output

The 'Testpoints' page of the Analyzer Script helps you to
configure the output of a Testpoint run.

By default the output 1s logged to the System Output
window, as 1n this example.

System Output v R

System Script Testpoints 4 4
StockExchange!Exchange. Stock. GetStockCost

Hoard Resources unit cost is §23.51
StockExchange!Exchange. Account. Credit

Credit: purchased 132 of stock "Hoard Resources” (id: 4)

Credit: cost §-3036

Total Test Count: 10

Total Passes: 10

Total Failures: 0

Total Invalid constraints: 0

Total Test Points encountered in run: 10
Total Test Points not encountered in run: 0

Total Test Points evaluated by Analyzer: 668

Simulation Events Breakpoints & Markers System Output | Execution Analyzer

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Test > Testpoints' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Test >
Testpoints' page

Ribbon Develop > Source Code > Execution

Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer > View
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Analyzer Scripts
Keyboard Shift+F12
Shortcuts
Options
Option Description
Output You can select from two options:
. 'Screen’' (the default) - The output 1s
directed to the '"Testpoints' tab of the
System Output window
. 'File' - The output 1s directed to file
Folder Click on the folder to use for Testpoint
log files.
Filename Enter the name to use for the Testpoint
log files.
Overwrite When this option is selected, the file

specified is overwritten each time a
Testpoint run is performed.

Auto Number = When this option is selected, the
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Testpoint output 1s composed of the
filename you specify and the number of
the Test run; each time you perform a
Test run the number 1s incremented.

Prefix trace When this option 1s selected, any trace

output with statements executed during the Testpoint
function run are prefixed with the current function
call.
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Debug Script

The process of configuring the Debug section of an
Analyzer Script 1s usually a one-time affair that rarely has to
be revisited. So once you have your script working, you
probably won't have to think about it again. The details you
provide are not complicated, yet defining a script provides
access to a great many benefits such as:

. Debugging

. Sequence diagram recording

. Executable StateMachine execution and simulation

. Test domain authoring and recording

. Behavioral profiling of processes on a variety of runtimes

All you need to do is select the appropriate platform and
enter some basic details. The debugger platforms you can
use include:

. Java

. Java Debug Wire Protocol (JDWP)

. Microsoft NET Debugger

. Microsoft Native Code Debugger (C++, C, VB)
. Mono

. The PHP Debugger

. The GNU Debugger (GDB)

Access
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Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard F6
Shortcuts

Notes

. An Analyzer script 1s not necessary for debugging
Enterprise Architect model scripts such as JavaScript or
VBScript
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Operating System Specific
Requirements

The Enterprise Architect debugger is able to operate on a
number of different platforms. This table describes the
individual requirements for debugging on each platform.

Platforms

Platform Detail

Microsoft . Microsoft™ NET Frameworks 4.0, 3.5
NET and 2.0
. Language support: C, C#, C++, J#,
VB.NET

Java . Java SE Development Kit from

Oracle™ (version 5.0 minimum)
(either 32 bit or 64 bit JDK)

The Java Platform Debugger Architecture
(JPDA) was introduced in Java SE
version 5.0. The JPDA provides two
protocols for debugging; the Java Virtual
Machine Tools Interface (JVMTI), and
the Java Debug Wire Protocol (JDWP).

Enterprise Architect's debugger supports
both protocols.
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GNU Enterprise Architect supports debugging
Debugger using the GNU Debugger, which enables
(GDB) you to debug your applications under

Linux either locally or remotely.
Requires GDB version 7.0 or higher.

The source code file path must not
contain spaces.

Windows for = Enterprise Architect supports debugging

Native native code (C, C++ and Visual Basic)

Applications = compiled with the Microsoft™ compiler
where an associated PDB file is available.

PHP Enterprise Architect enables you to
perform local and remote debugging of
PHP scripts in web servers.

Requires web server to be configured to
support PHP.

Requires PHP to be configured to support
XDebug PHP (3rd party PHP extension).

Notes

. The debugging facility 1s available in all editions of
Enterprise Architect
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UAC-Enabled Operating Systems

The Microsoft operating system Windows 7 provides User
Account Control (UAC) to manage security for applications.

The Enterprise Architect Visual Execution Analyzer is
UAC-compliant, and users of UAC-enabled systems can
perform operations with the Visual Execution Analyzer and
related facilities under accounts that are members of only
the Users group.

However, when attaching to processes running as services
on a UAC-enabled operating system, 1t might be necessary
to log in as an Administrator.

Log in as Administrator

Ste Action
p

1 | Before you run Enterprise Architect, right-click on
the Enterprise Architect icon on the desktop and
select the 'Run as administrator' option.

Alternatively

Edit or create a link to Enterprise Architect and configure
the link to run as an Administrator.
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Ste | Action
p

1 | Right-click on the Enterprise Architect icon and
select the 'Properties' option.

The Enterprise Architect 'Properties' dialog displays.

2 | Click on the Advanced button.
The 'Advanced Properties' dialog displays.

3 Select the 'Run as administrator' checkbox.

4 | Click on the OK button, and again on the 'Enterprise
Architect Properties' dialog.
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WINE Debugging

Configure Enterprise Architect to debug
under WINE

Ste Action
p

1 | Atthe command line, run $ winecfg.

2 | Select the 'Applications' tab. Add the Enterprise
Architect executable 'EA.exe' from the Enterprise
Architect installations folder. Then add these
programs from the VEA sub directories:

. SSampler32.exe
. SSampler64.exe
. SSProfiler32.exe
. SSProfiler64.exe

3 | Select each program in turn, then switch to the
'Libraries' tab. Ensure these values are listed with a
(native, built-in) precedence:

. dbghelp
. msxml4
. msxml6
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4 | Copy the application source code plus executable(s)
to your bottle.

The path must be the same as the compiled version;
that is:

If Windows source = C:\Source\SampleApp, under
Crossover 1t must be C:\Source\SampleApp.

5 | Copy any Side-By-Side assemblies that are used by
the application.

Permissions

An installation of Enterprise Architect contains some native
Linux programs that provide building and debugging
services to Enterprise Architect under Wine. These
programs need to checked using the Linux file system or
shell to ensure they have the 'Execute' permission set
appropriately. The programs are located in the
"VEA/x86/linux" subdirectory of the Enterprise Architect
installation.

Access Violation Exceptions

Due to the manner in which WINE handles direct drawing
and access to DIB data, an additional option is provided on
the drop-down menu on the Debug window toolbar to
1gnore or process access violation exceptions thrown when
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your program directly accesses DIB data.

Select this option to catch genuine (unexpected) access
violations; deselect it to ignore expected violations.

As the debugger cannot distinguish between expected and
unexpected violations, you might have to use trial and error
to capture and inspect genuine program crashes.

Notes

. If WINE crashes, the back traces might not be correct

. If you are using MFC remember to copy the debug
side-by-side assemblies to the C:\window\winsxs
directory

. To add a windows path to WINE, modify the Registry
entry:

HKEY LOCAL_ MACHINE\System\CurrentControlSet\
Control\Session Manager\Environment
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Java

This section describes how to set up Enterprise Architect for
debugging Java applications and Web Servers.
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General Setup for Java

The general setup for debugging Java Applications supports
two options:

. Debug an Application
. Attach to an application that is running

Option 1 - Debug an Application

Field Action
Debugger Select Java.

x64 Select this checkbox i1f you are debugging
a 64 bit application.

Deselect the checkbox if you are
debugging a 32 bit application.

Mode Select Run.

Default This path 1s added to the class path

Directory property when the Java Virtual Machine
is created.

Application  Identify the fully qualified Class name to
Class debug; the Class must have a method
declared with this signature:
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Line
Arguments

Java Virtual
Machine
Options
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public static void main(String());

Application Class samples, Collector

Command Line “param1” param2 “param3” param4
Arguments:

Specify any parameters to be passed to
the main method of the Application
Class.

Parameters containing spaces should be
surrounded with double quotes.

Specify command line options for Virtual
Machine creation.

You also must provide a parameter for
the Java Runtime Environment (JRE) as
the path to be searched for the jvm.dll;
this 1s the DLL supplied as part of the
runtime environment or JDK from Sun
Microsystems™,

The JRE parameter can be either:

. An Enterprise Architect-defined Local
Path

. An absolute file path (with no double
quotes) to the installation folder of the
Java JDK to be used for debugging

The JRE parameter must point to the
installation folder for the Java JDK. A
JDK installation is necessary for
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debugging to succeed. The JRE should
not point to the installation of the public
Java Runtime Environment, if that 1s
installed. Environment variables can be
used when specifying the VM startup
options, such as classpath.

For example, using:

. An Enterprise Architect Local Path
JAVA and an environment variable
classpath:

Java Virtual Machine Options:
JRE=%:]AVA%:, Diava.dass. path="%dasspath%%;.;

. Or an absolute path to the JDK
installation directory and an
environment variable classpath:

Java Virtual Machine Options:
JRE=C:'Program Files (x36)Javatjdk 1. 7.0,-Djava. dass. path=%casspath %s; .}

In these two examples, the debugger will
create a virtual machine using the JDK
located at the value of the JRE parameter.

If no classpath is specified, the debugger
always creates the virtual machine with a
class path property equal to any path
contained in the environment variable
plus the path entered in the default
working directory of this script.

If source files and .class files are located
under different directory trees, the
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classpath property MUST include both
root path(s) to the source and root path(s)
to binary class files.

Option 2 - Attach to Virtual Machine

There 1s very little to specify when attaching to a VM;
however, the VM must have the Sparx Systems debugging
agent loaded.

Field Action
Debugger Select Java

Mode Select Attach to Virtual Machine
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Advanced Techniques

In addition to the standard Java debugging techniques, you
can:

. Attach to Virtual Machine

. Internet Browser Java Applets
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Attach to Virtual Machine

You can debug a Java application by attaching to a process
that 1s hosting a Java Virtual Machine; you might want to do
this for attaching to a webserver such as Tomcat or JBOSS.

The Java Virtual Machine Tools Interface from Sun
Microsystems is the API used by Enterprise Architect; it
allows a debugging agent to be specified when the JVM is
created.

To debug a running JVM from Enterprise Architect, the
Sparx Systems' debugging agent must have been specified
as a startup option to the JVM when it was started; how this
is accomplished for products such as Tomcat and JBOSS
should be provided by that product's own documentation.

For java.exe, the command line option to load the Enterprise
Architect debugging agent could be (depending on your
environment):

. -agentpath:"c:\program files\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

. -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

. -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"

The appropriate option will depend on your operating
system and whether you are working on a 32 bit application
or a 64 bit application.

Alternatively, if you add the appropriate VEA directory to
your PATH environment variable you can choose to use:
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. -agentlib:SSJavaProfiler32
. -agentlib:SSJavaProfiler64

It 1s not necessary to configure an Analyzer Script when you
attach to a Virtual Machine; you can just use the Attach
button on one of the Analyzer toolbars.

If you configure an Analyzer Script, there are only two
things that must be selected:

. Select 'Java' as the debugging platform
. Choose the 'Attach to Virtual Machine' option
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Internet Browser Java Applets

This topic describes the configuration requirements and
procedure for debugging Java Applets running in a browser
from Enterprise Architect.

Attach to the browser process hosting the
Java Virtual Machine (JVM) from Enterprise
Architect

Ste Action
p

1 | Ensure binaries for the applet code to be debugged
have been built with debug information.

2 | Configure the JVM using the Java Control Panel.

3 Inthe 'Java Applet Runtime Settings' panel, click on
the View button.

4 | On the installed version to use, include one of these
options in the 'Runtime Parameters' field, depending
on your environment and whether you are working
on a 32 bit application or a 64 bit application:

-agentpath:"c:\program files\sparx
systems\ea\VEA\x86\SSJavaProfiler32"
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-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"

5 | In this field add the required Class paths.

At least one of these paths should include the root
path of the source files to use in debugging.

6 | Set breakpoints.
7 | Launch the browser.

8 | Attach to the browser process from Enterprise
Architect.
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Working with Java Web Servers

If you are debugging Java web servers such as JBOSS and
Apache Tomcat (both Server configuration and Windows
Service configuration) in Enterprise Architect, apply these
configuration requirements and procedures.

Note: The debug and record features of the Visual
Execution Analyzer are not supported for the Java server
platform 'Weblogic' from Oracle.

Attach to process hosting the Java Virtual

Machine from Enterprise Architect

Ste Action
P

| Build binaries for the web server code to be
debugged, with debug information.

2 | Launch the server with the '"Virtual Machine startup'
option, described in Server Configuration.

3 | Import source code into the Enterprise Architect
Model, or synchronize existing code.

4 | Set breakpoints.
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5 | Launch the client.

6 | Attach to the process from Enterprise Architect.

Server Configuration

The configuration necessary for the web servers to interact
with Enterprise Architect must address these two essential
points:

. Any VM to be debugged, created or hosted by the server
must have the Sparx Systems Agent command line option
specified or in the VM startup option (that is:

-agentlib:SSJavaProfiler32 or
-agentlib:SSJavaProfiler64)

. The CLASSPATH, however it is passed to the VM, must
specify the root path to the Package source files

The Enterprise Architect debugger uses the java.class.path
property in the VM being debugged, to locate the source file
corresponding to a breakpoint occurring in a Class during
execution; for example, a Class to be debugged 1s called:

a.b.C
This 1s located 1n physical directory:
C:\source\a\b

So, for debugging to be successful, the CLASSPATH must
contain the root path:

c:\source
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Analyzer Script Configuration

Using the 'Debug' tab of the 'Build Script' dialog, create a
script for the code you have imported and:

. Select the 'Attach to process' radio button and, in the field
below it, type 'attach'’

. In the 'Use Debugger' field, click on the drop-down arrow
and select 'Java'

All other fields are unimportant; the 'Directory’ field is
normally used in the absence of any Class path property.

Run the Debugger

The breakpoints could show a question mark. In this case
the Class might not have been loaded yet by the VM. If the
question mark remains even after you are sure the Class
containing the breakpoint has been loaded, then either:

. The binaries being executed by the server are not based on
the source code

. The debugger cannot reconcile the breakpoint to a source
file (check Class paths), or

. The JVM has not loaded the Sparx Systems agent

Ste Action
p

1 | Run the server and check that the server process has
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loaded the Sparx Systems Agent:
DLL SSJavaProfiler32.DLL or SSJavaProfiler64

Use 'Process Explorer' or similar tools to prove that
the server process has loaded the agent.

2 In Enterprise Architect, open the source code and set
some breakpoints.

3 | Click on the Run Debug button in Enterprise
Architect.

The 'Attach To Process' dialog displays.
4  Select the server process hosting the application.

5 | Click on the OK button.

A confirmation message displays in the Debug
window, stating that the process has been attached.
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JBOSS Server

In this JBoss example, for a 32 bit application, the source
code for a simple servlet is located in the directory location:

C:\Benchmark\Java\]BOSS\Inventory

The binaries executed by JBOSS are located in the
JAW .EAR file in this location:

C:\JBOSS\03b-dao\build\distribution

The Enterprise Architect debugger has to be able to locate
source files during debugging; to do this it also uses the
CLASSPATH, searching in any listed path for a matching
JAV A source file, so the CLASSPATH must include a path

to the root of the Package for Enterprise Architect to find
the source during debugging.

This is an excerpt from the command file that executes the
JBOSS server; the Class to be debugged 1s at:

com/inventory/dto/carDTO

Therefore, the root of this path 1s included in the
JBOSS CLASSPATH.

Example Code

set SOURCE=C:\Benchmark\Java\JBOSS\Inventory
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set JAVAC JAR=%JAVA HOME%\lib\tools.jar
if "%JBOSS CLASSPATH%" =""
(

set
JBOSS CLASSPATH=%SOURCE%;%JAVAC JAR%:;%
RUNJAR%;

)

else

(

set
JBOSS CLASSPATH=%SOURCE%;%JBOSS CLASSPA
TH%;%JAVAC JAR%;%RUNJAR%;

)
set JAVA OPTS=%JAVA OPTS% -agentpath:"c:\program
files\sparx systems\vea\x86\ssjavaprofiler32"
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The Apache Tomcat Server can be configured for debugging
using the Java debugger in Enterprise Architect. This
example shows the configuration dialog for Apache Tomcat

7.0 on a PC running Windows 7.

‘g. Apache Tomcat 7.0 Tomecat? Properties Iﬂ

| General I Log On | Logging | Java |513r11.||:| | Shutdown

[ Use default
Java Virtual Machine:

Java Classpath:
C:\Tomcat\webappsiservliet\WEB-INFisrc; C: \Tomcat\bin\bootstrap jar; C

Java Options:

C:\Program Files (x36)Javayjdk 1. 7.0_04rebinidientjvm.dl D

-Djava.util.logging. manager =org. apache. juli. ClassLoaderLogManage  »
Djava.util.logging. config. file=C: {Tomcatconfiogging. properties
=ntpath; ara 03 86 j

Initial memory poal: MB
Maximum memaory pools ME
Thread stack size: KB
[ Ok ] [ Cancel ] [ Apply

)

These three points are important:

. The 'Java Virtual Machine' specifies the runtime from an

installation of the Java JDK

. The source path to any servlet to be debugged 1s added to
Java Classpath; in this case we add the path to the Tomcat

servlet:

c:\tomcat\webapps\servlet\ WEB-INF\src

. The 'Java Options' include the path to the Sparx Systems

debugging agent:
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-agentpath:c:\program files (x86)\sparx
systems\vea\x86\ssjavaprofiler32
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Apache Tomcat Windows Service

Configuration

For users running Apache Tomcat as a Windows™ service,
it 1s important to configure the service to enable interaction
with the Desktop; failure to do so causes debugging to fail

within Enterprise Architect.

Log on as:

@ Local System account
Allow service to interact with desktop

Select the 'Allow service to interact with desktop' checkbox.
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NET

This section describes how to configure Enterprise Architect
for debugging .NET applications. It includes:

. General Setup for .NET

. Debugging an Unmanaged Application
. Debug COM Interop

. Debug ASP .NET
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General Setup for .NET

This is the general setup for debugging Microsoft NET
applications. You have two options when debugging:

. Debug an application
. Attach to an application that is running

Option 1 - Debug an application

Field Action

Debugger Select Microsoft .NET as the debugging
platform.

x64 Select this checkbox i1f you are debugging
a 64 bit application.

Deselect the checkbox if you are
debugging a 32 bit application.

Mode Select the Run radio button.

Default This 1s set as the default directory for the

Directory process being debugged.

Application Select and enter either the full or the

Path relative path to the application
executable.
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. If the path contains spaces, specify the
full path; do not use a relative path

. If the path contains spaces, the path
must be enclosed by quotes

Command Parameters to pass to the application at

Line start up.

Arguments

Show Create a console window for the

Console debugger; not applicable to attaching to a
process.

Symbol Specify any additional paths to locate

Search Paths | debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running

Field Action

Debugger Select Microsoft .NET as the debugging
platform.

x64 Select this checkbox 1f you are debugging
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a 64 bit application.

Deselect the checkbox 1f you are
debugging a 32 bit application.

Mode Select the Attach to Process radio button.
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Debugging an Unmanaged Application

If you are debugging managed code using an unmanaged
application, the debugger might fail to detect the correct
version of the Common Language Runtime (CLR) to load.

You should specify a config file i1f you don’t already have
one for the debug application specified in the Debug
command of your script.

The config file should reside in the same directory as your
application, and take the format:

name.exe.config
where 'name' is the name of your application.

The version of the CLR you specify should match the
version loaded by the managed code invoked by the
debuggee.

In the sample code that follows, "clr version" represents the
version of the CLR targeted by your plug-in or COM code.

Sample Config File

<configuration>
<startup>
<requiredRuntime version="clr_version"/>
</startup>

</configuration>
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Debug COM Interop

Enterprise Architect enables you to debug .NET managed
code executed using COM in either a Local or an In-Process
server.

This feature 1s useful for debugging Plug-ins and ActiveX
components.

Debug .NET Managed Code Executed Using
coM

Ste Action
p

1  Create a Package in Enterprise Architect and import
the code to debug.

2 | Ensure the COM component is built with debug
information.

3 | Create a Script for the Package.

4 | In the 'Debug | Platform' page, you can select to
either attach to an unmanaged process or specify the
path to an unmanaged application to call your
managed code.
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5 | Add breakpoints in the source code to debug.

Attach to an Unmanaged Process

If you are using:
. An In-Process COM server, attach to the client process
. A Local COM Server, attach to the server process

Click on the Debug window Run button (or press F6) to
display a list of processes from which you can choose.

Notes

. Detaching from a COM interop process you have been
debugging terminates the process; this is a known issue

for Microsoft .NET Framework, and information on it can
be found on many of the MSDN .NET blogs
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Debug ASP .NET

Debugging for web services such as ASP requires that the
Enterprise Architect debugger is able to attach to a running
service.

Begin by ensuring that the directory containing the ASP
NET service project has been imported into Enterprise
Architect and, if required, the web folder containing the
client web pages.

If your web project directory resides under the website
hosting directory, you can import from the root and include
both ASP code and web pages at the same time.

It 1s necessary to launch the client first, as the ASP .NET
service process might not already be running; load the client
using your browser - this ensures that the web server 1s
running.

In the debug set up you would then select the 'Attach' radio
button. When this choice is selected, the debugger will
prompt you each time for the process to debug.

Click on the Debug window Run button to start the
debugger; the 'Attach To Process' dialog displays.

The name of the process varies across Microsoft operating
systems, as explained in the ASP .NET SDK; for example,
on Windows XP, the name of the process resembles

aspnet wp.exe, although the name could reflect the version
of the .NET framework that it 1s supporting.

There can be multiple ASP.NET processes running under
XP; you must ensure that you attach to the correct version,
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which would be the one hosting the .NET framework
version that your application runs on; check the web.config
file for your web service to verify the version of .NET
framework 1t 1s tied to.

The Debug window Stop button should be enabled and any
breakpoints should be red, indicating they have been bound.

You can set breakpoints at any time in the web server code.
You can also set breakpoints in the ASP web page(s) if you
imported them.

Notes

Some breakpoints might not have bound successfully, but if
none at all are bound (indicated by being dark red with
question marks) something has gone out of synchrony; try
rebuilding and re-importing source code
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The Mono Debugger

Mono i1s a software platform sponsored by the .NET
Foundation to facilitate cross-platform development. It is
popular with game developers for its rich gaming,
API-based and portability features.

Enterprise Architect provides support to the Mono
community by providing a modern environment for both
modeling and developing software. Existing projects can be
imported, built and debugged natively on both Linux and
Windows.

Overview

Debugging under Mono involves the cooperation of three
processes. The Mono runtime manages the application and
communicates using a socket protocol with the Enterprise
Architect Debugger, which in turn communicates with
Enterprise Architect acting as the front end. When you
launch Mono you need to direct it to support debugging,
which you achieve using a command line directive in which
you name the host and Port number that Mono should listen
on. The host can be omitted, in which case Mono will accept
connections from any IP address. The host can have the
value 'localhost' to restrict connections to the same machine.
The Port number is a number of your choosing.

The host and Port number are the important pieces of
information, as they are used when configuring the Analyzer
Script.
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Requirements for Windows

. Enterprise Architect (version 14 minimum)
. Mono for Windows (version 5.4 minimum)

Requirements for Linux

. Enterprise Architect (version 14 minimum)
. Mono for Linux (version 5.4 minimum)
. Wine for Linux

The Runtime Host Page

This page is optional and 1s only useful where Mono and
Enterprise Architect will be running on the same machine. It
provides the ability to run Mono first with the required
debugging directives, before the Enterprise Architect
debugger 1s started. After the debugger connects, it resumes
the Mono runtime, which has been started as suspended. If
the application runs on a different machine from the
Enterprise Architect you are using, you should clear this
section.

(c) Sparx Systems 2023 Page 84 of 237



Build and Debug 13 November, 2023

Debugging Configuration Linux

Debugger Configuration

This section describes the Debug section of an Analyzer
Script in respect to debugging Mono under Linux. Fields
that are not listed here are not required.

Debugger Select 'Mono'.

Default This is the fully qualified native Linux
Directory path where the application is located in
Unix format.

Connection . port: the debugging Port

. host: the name or IP address of the
machine where Mono runs ('localhost'
if the machine is the same)

. localpath: the root path of the source
code in Windows format; this is the
path to the source files that you use to
set breakpoints in the code editor in
Enterprise Architect

. remotepath: the root path of the source
code in Unix format, this being the path
to the source files used to build the
program under Linux
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These paths are returned during debug
events, and are then mapped to the
local path, so that Enterprise Architect
can display the source file during a
breakpoint or step - both parameters
can specify the same physical source
file root, but must use the Windows or
Unix format for each field

. shutdown: (true or false); when true the
VM is terminated when the Debugger
1s stopped

. timeout: the timeout in milliseconds for
socket calls

. output: the Wine / Windows path of the
log file to write to

. logging: (true or false); when true,
extra messages are logged in the Debug
window and socket messages are
logged to the specified output file

Starting Mono Automatically

You can configure Enterprise Architect to start Mono for
you when you start the debugger. You do this by
configuring the 'Runtime Host' page of your Analyzer
Script. The format of the commands 1s described here:
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cd path-to-program

/usr/bin/mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program

where:

- path-to-program 1s the directory path where the program is
located

- host 1s one of these:
localhost

an IP address

a networked machine name

- port is the Port for the socket

- program 1s the name of the application (such as
MonoProgram.exe)

Starting Mono Manually using the Command
Line

You can start Mono manually from a console. Locate the
program in your file explorer, then open a console at that
location. The format of the command line is described here:

/ust/bin/mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program

where host 1s one of these:
. localhost
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. an IP address
. a networked machine name

port is the Port for the socket and program is the name of
the application (for example, MonoProgram.exe).
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Debugging Configuration Windows

Debugger Configuration

This section describes the Debug section of an Analyzer
Script in respect to debugging Mono under Windows.
Fields that are not listed here are not required.

Field Description

Debugger Select 'Mono'.

x64 Select if the program to be debugged 1s a
64 bit executable.

Run or Choose 'Run' to name the program to

Attach launch. Choose 'Attach’ if you will

always attach to a running process.

Default The default directory that the program
Directory will take when 1t runs.

Application The full path of the Mono application.
Path

Command Any parameters to pass to the program. If
Line the parameters contain spaces, surround
Arguments them 1n double quotes (")
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Starting Mono Automatically

You can configure Enterprise Architect to start Mono for
you when you start the debugger. You do this by
configuring the 'Runtime Host' page of your Analyzer
Script. The format of the commands 1s described here:

cd path-to-program

mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program

where:

- path-to-program is the directory path where the program is
located

- host 1s one of these:

. localhost

. an IP address

. a networked machine name

- port 1is the Port for the socket

- program 1s the name of the application (such as
MonoProgram.exe)

Starting Mono Manually using the command
line

You can start Mono manually from a console. Locate the
program in your file explorer, then open a console at that
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location. The format of the command line 1s described here:

mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser

ver=y,suspend=y program
where host 1s one of these:

. localhost

. an IP address

. anetworked machine name

port 1s the Port for the socket and program 1s the name of
the application (for example, MonoProgram.exe).
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The PHP Debugger

The Enterprise Architect PHP Debugger enables you to
debug PHP.exe scripts. This section discusses basic set up
and the various debugging scenarios that are commonly
encountered; the scenarios concern themselves with the
mapping of file paths, which 1s critical to the success of a
remote debugging session.

. Script Setup

Local Windows Machine (Apache Server)
Local Windows Machine (PHP.exe)
Remote Linux Machine (Apache Server)
Remote Linux Machine (PHP.exe)

Setup and Scenarios

Scenario Details

Script Setup | An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the toolbar of the
Execution Analyzer.

Select PHP.XDebug as the debugging
platform; when you select this platform
the property page displays these
connection settings:

. host - localhost - The adaptor that
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Enterprise Architect listens on for
incoming connections from PHP

. localpath - %LOCAL% - Specifies the
local file path to be mapped to a remote
file path; this is a remote debugging
setting - for local debugging, clear the
value, the value 1s a placeholder and
you should edit it to fit your particular
scenario

. remotepath - %REMOTE% - Specifies
the remote file path that a local file
path 1s to be mapped to; this 1s a remote
debugging setting - for local
debugging, clear the value, the value is
a placeholder and you should edit it to
fit your particular scenario

. logging - Enter true or false to enable
logging of communication from
XDebug server

. output - names the file path on the
remote machine to be used with the
logging option; this file will always be

overwritten
Local In this situation, consider this
Machine configuration:
Apache . O/S: Windows7

Server . Network computer name: MyPC
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. Network share MyShare mapped to
c:\myshare

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts

. Apache document root 1s set to
//MyPC/MyShare/apache

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000

. localpath: c:\myshare\apache\

. remotepath: MyPC/MyShare/apache/

Local In this scenario an Analyzer Script for the

Machine connection parameters might be

PHP.EXE configured as shown, as file paths always
map to same physical path:

. host: localhost
. port: 9000

. localpath:

. remotepath:

Remote In this situation consider this
Linux configuration:

Machine Local Machine:

Apache
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Server . O/S: Windows7

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts

Remote Machine:
. O/S: Linux

. Apache document root is set to
home/apache/htdocs

. Source files in Apache are located at
home/apache/htdocs/myapp/scripts

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000

. localpath: c:\myshare\apache\

. remotepath: home/apache/htdocs/

Remote In this situation consider this
Linux configuration:

Machine . Local Machine

PHP.exe . O/S: Windows7

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts

. Remote Machine
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. O/S: Linux

. Source files in Apache located at
home/myapp/scripts

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000
. localpath: c:\myshare\apache\
. remotepath: home/

When you are at a breakpoint, you can
examine the values of PHP globals using
the Analyzer Watches window. To list
every global, type either 'globals' or
'superglobals' into the field. To show an
individual item, enter its name. This
image shows the value of the PHP
environment variable § SERVER being
displayed.

Watches v %
$_SERVER ==
Variable Value Type Address
= & $_SERVER array[31] 000000010 | a

& $_SERVER[O] "127.0.0.1" string 0000001

& $_SERVER[1] "keep-alive" string Ox0000001d

& $_SERVER[Z] "max-age=0" string Ox0000001e

& $_SERVER[3] "1 string 0000001F

& $_SERVER[4] "Mozilla/5.0 (X11; Linux x86_&4) AppleW string 00000020

& $_SERVER[5] "text/html,application/xhtml+xml,applic string Ox00000021

& $_SERVER[E] "gzip, deflate, sdch" string Ox00000022

& $_SERVER[T] "en-US,en; g=0.8" string Ox00000023

& $_SERVER[2] "fusr/lecal/sbin:fusrflocal/bin:fusrfsbin:/ string 00000024

@& $_SERVER[9] "<address=Apache/2.4 7 (Ubuntu) Serv string (00000025

("W §_SERVER[10] "Apache/2.4.7 (Ubuntu)" string (00000026

& $_SERVER[11] "127.0.0.1" string 00000027

& $_SERVER[12Z] "127.0.0.1" string 00000028 | w
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PHP Debugger - System Requirements

This topic identifies the system requirements and operating
systems for the Enterprise Architect PHP debugger.

System Requirements:

. Enterprise Architect version 9
. PHP version 5.3 or above
. PHP zend extension XDebug 2.1 or above

. For web servers such as Apache, a server version that
supports the PHP version

Supported Operating Systems:

. Client (Enterprise Architect)

. Microsoft Windows XP and above
. Linux running Crossover Office

. Server (PHP)

. Microsoft Windows XP and above

. Linux
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PHP Debugger Checklist

This topic provides a troubleshooting guide for debugging
PHP scripts in Enterprise Architect.

Check Points

Check Point | Details

System . Apache HTTP Web Server version 2.2
Requirements ., PHP version 5.3 or above

. XDebug version 2.1.1

Enterprise . The model has an Analyzer Script
Architect configured to use the PHP XDebug
platform

. PHP source code has been imported
into the model (for recording and
testpoints)

. When the PHP XDebug platform is
selected from the 'Analyzer Script'
dialog, default runtime settings are
listed in the 'Connection' field:

localpath:%LOCAL%
remotepath:%REMOTE%

Either define local paths for these default
variables or edit the script to provide
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actual paths.
For example: local source, remote source

localpath:c:\code
samples\vea\php\sample

remotepath:webserver/sample
. 'webserver' is a network or local share
. 'sample' is a folder below share

PHP In order to debug PHP scripts in
Enterprise Architect, it is a requirement
that the PHP 1s configured properly to
load the XDebug extension.

Settings similar to these should be used
(for XDebug version 3 or higher):

. [xdebug]

. zend_extension=xdebug.so

. xdebug.mode=debug

. xdebug.mode=debug

. xdebug.start with request=yes
. xdebug.client host=localhost
. xdebug.client port=9003

For Xebug versions less than 3 use the
old settings such as:

. [xdebug]
. xdebug.extended info=1
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. xdebug.idekey=ea
. xdebug.remote_ enable=1
. xdebug.remote handler=dbgp
. xdebug.remote autostart=1
. xdebug.remote host=X.X.X.X
. xdebug.remote port=9000

. xdebug.show local vars=1

The IP address X.X.X.X refers to and
should match the host specified in the
model Analyzer Script.

The IP address is the address XDebug
connects with and the same address the
Enterprise Architect PHP agent listens
on.

Apache For debugging using Apache, these lines
should be present in the Apache
configuration file, httpd.conf:

LoadModule php5 module
"php home/phpSapache2 2.dI1"

AddHandler application/x-httpd-php
.php
PHPIniDir "php home"

The value "php home" 1s the PHP
installation path (the path where php.ini
and apache dlII exist).
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Troubleshoot = To prevent both PHP and Apache
ing timeouts during a debugging session,
these settings might require modification.

The settings were used while developing
the PHP Debugging agent in Enterprise
Architect.

PHP File: php.ini
; Enterprise Architect prevents PHP

timeouts when debugging PHP
extensions

max_execution time =0

; Enterprise Architect prevents web
server timeouts when debugging PHP
extensions

max_input time = -1

; Enterprise Architect logs errors
display errors = On

; Enterprise Architect displays startup
errors

display startup errors = On

Apache File: httpd.conf
; Enterprise Architect prevents timeouts
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while debugging php extensions
Timeout 60000
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The GNU Debugger (GDB)

When debugging your applications you can use the GNU
Debugger (GDB), which is portable and runs on Unix-like
systems such as Linux, as well as on Windows. The GDB
works for many programming languages including Ada,
Java, C, C++ and Objective-C. Using the GDB, you can
debug your applications either locally or remotely.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Debug > Platform' page  or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Platform' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Context Browser window | Right-click on
Menu Package | Execution Analyzer
Keyboard Shift+F12

Shortcuts

(c) Sparx Systems 2023 Page 104 of 237



Build and Debug

13 November, 2023

Set up the GNU Debugger

Task

Set up Script

Define
Connection
Settings
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Details

An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the Execution
Analyzer toolbar.

On the 'Platform’' page of the Execution
Analyzer Script Editor, in the 'Debugger’
field click on the drop-down arrow and
select 'GDB'.

The property panel displays a number of
connection settings for which you
provide values.

. path - <path> - The complete file path
of the GDB executable; you only
specify this i1f the GDB cannot be
found 1n the system path

. source - <path>, <path> - The path in
which the debugger will search for
source files, 1f they do not reside in the
executable directory

. remote - F - Set for remote debugging;
otherwise leave blank

. port - <nnnnn> - The Port to connect to
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on the remote server

. host - localhost - The host name to
connect to

. fetch - T - Set to retrieve the binary
from the remote system

. dumpgdb - <path> - The filename to
write the GDB output to

. 1nitpath - <path> - The complete file
path to the gbinit file

Notes

. A requirement of the GDB is that your source code file
path does not contain spaces; the debugger will not run
correctly with spaces in the file path
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The Android Debugger

If you are developing Java applications running on Android
devices or emulators, you can also debug them. The Local

and Remote machines can be on either a 32 bit platform or a
64 bit platform.

Remote Machine .
Local Machine
ExecutionEnvironment . .
ExecutionEnvironment

Android Debug
Bridge (ADB) Android Emulator

System Requirements

On the Remote machine, this software 1s required:

. Android SDK, which includes the android debug bridge,
ADB (you need to be familiar with the SDK and its tools)

. Java JDK (32 and 64 bit support)

(c) Sparx Systems 2023 Page 107 of 237



Build and Debug 13 November, 2023

. Port Forwarding software (3rd party)

On the Local machine, this software is required:
. Enterprise Architect Version 10 or higher

Analyzer Script Settings

Field/Button @ Action

Debugger Click on the drop-down arrow and select
Java (JDWP).

Run Click on this radio button.

Default Not applicable - leave blank.

Directory

Application  Not applicable - leave blank.
path

Command Not applicable - leave blank.
Line
Arguments

Build first Not applicable - leave blank.

Show Not applicable - leave blank.
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console

Show Not applicable - leave blank.
diagnostic
messages

Connection Not applicable - leave blank.

Port This 1s the application port,
forward-assigned using adb or other
means, through which Enterprise
Architect and the Android Virtual
Machine (VM) can communicate.

Host Host computer (defaults to localhost)

If Android is running on an emulator on a
device attached to a networked computer,
enter the network name here.

By default, debugging will attempt to
connect to the Port you specify on the
local machine.

Source This is the source equivalent of the
classpath setting in Java.

The root to each source tree should be
listed. If more than one is specified, they
should be separated by a semi-colon; that
1S:
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c:\myapp\src;c:\myserver\src

Y ou must specify at least one root source
path.

When a breakpoint occurs the debugger
searches for the java source in each of the
source trees listed here.

Logging Enables logging additional information
from debugger

possible values: true,false,1,0,yes,no

Output Specifies the full name of the local log
file to be written.

The folder must exist or no log will be
created.

The log file typically contains a dump of
bytes sent between debugger and VM.

Platform If you are debugging Java running under
any android scenario, select Android.

For all other scenarios, select Java.

Configure Ports for Debugging - Port
Forwarding (Local)
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The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged can be assigned using ADB,
which 1s supplied with the Android SDK.

Before debugging, start the application once in the device.
When the app starts, discover its process identifier (pid):

adb jdwp
The last number listed is the pid of the last application
launched; note the pid and use it to allow the debugger to
connect to the VM:
. adb forward tcp:port jdwp:pid
- port = Port number listed in analyzer script
- pid = process id of the application on the device

Configure Ports for Debugging - Port
Forwarding (Remote)

To debug remotely, the same procedure should be followed
as for the local machine, but the communication requires
additional forwarding as the socket created using the adb
forward command will only listen on the local adapter. The
socket is bound to the localhost, and attempts to connect to
this Port will be met with 'connection refused' messages.

In order to achieve remote debugging it is necessary to have
a proxy running on the remote machine that listens to all
incoming connections and forwards all traffic to the adb
Port; there are numerous software products available to do

(c) Sparx Systems 2023 Page 111 of 237



Build and Debug 13 November, 2023

this.

Remote debugging with Enterprise Architect will not work
unless you have configured a proxy Port forwarder.
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Java JDWP Debugger

Java provides two main debugging technologies: an
in-process agent-based system called the Java Virtual
Machine Tools Interface (JVMTI) and a socket-based
paradigm called the Java Debug Wire Protocol (JDWP). A
Java Virtual Machine can name either one of these but not
both, and the feature must be configured when the JVM 1is
started.

System Requirements

1. The Enterprise Architect JDWP debugger will only be
able to communicate with a JVM started with the 'JTDWP'
option. Here 1s an example of the command line option:

java
-agentlib:;jdwp=transport=dt socket,address=localhost:90
00,server=y,suspend=n -cp "c:\java\myapp;%classpath%"
demo.myApp "param1" "param2"

2. The Virtual Machine should not be currently attached to a
debugger.

3. It 1s not possible for a VM to be debugged by Enterprise
Architect and Eclipse at the same time.

Analyzer Script Settings

Field/Button | Action
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Debugger Click on the drop-down arrow and select
Java (JDWP).
Run Click on this radio button to run the

debugger when the script is executed.

Default Not applicable - leave blank.
Directory

Application  Not applicable - leave blank.
path

Command Not applicable - leave blank.
Line

Arguments

Build first Not applicable - leave blank.

Show Not applicable - leave blank.
console

Show Not applicable - leave blank.
diagnostic

messages

Connection Not applicable - leave blank.

Port Set the application Port forward-assigned
to the VM process during start-up, in the
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Java command-line options.

Host Set the host computer (defaults to
localhost)

If VM is running on a networked
computer, enter the network name or url
here.

By default debugging will attempt to
connect to the Port you specify on the
local machine.

Source This is the source equivalent of the
classpath setting in Java.

List the root to each source tree; specify
at least one root source path. If you
specify more than one, separate them
with a semi-colon; for example:

c:\myapp\src;c:\myserver\src

When a breakpoint occurs the debugger
searches for the Java source in each of the
source trees listed here.

Logging Enable or disable logging of additional
information from the debugger.

Possible values include:
. true

. false

. 1
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. yes
. NO

Output Specify the full name of the local log file
to be written. If the folder does not
already exist, no log will be created.

The log file typically contains a dump of
bytes sent between the debugger and VM.

Platform Select Java.

Configure Ports for Debugging

The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged 1s assigned when the VM i1s
created.

Local Debugging

Where both Enterprise Architect and the Java VM are
running on the same machine, you can perform local
debugging. It 1s necessary to launch the VM with the JDWP
transport enabled - see the documentation on Java Platform
Debugger Architecture (JPDA) at Oracle for the command
line option specifications. For example:
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java
-agentlib:;jdwp=transport=dt socket,address=localhost:9000,
server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%" samples.MyApp
"paraml" "param?2"

In this example the values for the Analyzer script would be
'host: localhost' and 'port:9000'.

Remote Debugging

Where Enterprise Architect is running on the local machine
and the Java VM is running on a remote machine, you can
perform remote debugging. It is necessary to launch the VM
with the JDWP transport enabled - see the documentation on
JPDA at Oracle for the command line option specifications.
Here 1s an example, where the remote computer has the
network name testmachinel :

java
-agentlib:;jdwp=transport=dt socket,address=9000,server=y,
suspend=n -cp "c:\samples\java\myapp;%classpath%"
samples.MyApp "param1" "param2"

Note the absence of a host name in the address. This means
the VM will listen for a connection from any machine. In
this example the values for the Analyzer script would be
'host: testmachinel' and 'port: 9000'.
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Tracepoint Output

The Tracepoints page of the Analyzer Script enables you to
direct where the output from any Trace statements goes
during a debug session.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Debug > Tracepoints' page  or

. Click on & - in the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Tracepoints' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer > select and

run script
Context Browser window | Right-click on
Menu Package | Execution Analyzer
Keyboard Shift+F12

Shortcuts

Tracepoint properties
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Field Detail

Output You can select from two options:

. 'Screen’' (the default) - The output 1s
directed to the Debug window

. 'File' - The output 1s directed to file

Folder Enter the folder to use for Trace
statement log files.

Filename Enter the name to use for the Trace
statement log files.

Overwrite If selected, the specified file is
overwritten each time a debug session is
started.

Auto Number If selected, the Trace log file is composed
of the filename you specify and a
number.

Each time you start a debug session, the
number 1s incremented.

Prefix trace If selected, any Trace statements
output with executed during the debug session run are
function prefixed with the current function call.
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Workbench Setup

This topic describes the requirements for setting up the
Object Workbench on Java and Microsoft .NET.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Debug > Workbench' page  or

. Click on - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Workbench' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts
Platforms
Platform Detail
Platforms The Workbench supports these platforms:
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Supported . Microsoft .NET (version 2.0 or later)
. Java (JDK 1.4 or later)

Microsoft The .NET workbench requires an
NET assembly, which 1s used to create the
Workbench workbench items.

Y ou specify the path to the assembly on
the 'Workbench' page of the Analyzer
Script.

There are two constraints in using the
NET workbench:

. Members defined as struct in managed
code are not supported

. Classes defined as internal are not
supported

Java The Java workbench uses the Virtual

Workbench Machine settings configured in the
Analyzer Script 'Debug' page to create
the JVM.
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Microsoft C++ and Native (C, VB)

You can debug native code only if there is a corresponding
PDB file for the executable. A PDB file is created as a result
of building the application.

The build should include full debug information and there
should be no optimizations set.

The script must specify two things to support debugging:
. The path to the executable
. Microsoft Native as the debugging platform
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General Setup

This is the general setup for debugging Microsoft Native
Applications (C++, C, Visual Basic). You have two options
when debugging:

. Debug an application
. Attach to an application that is running

Option 1 - Debug an application

Field Action

Debugger Select Microsoft Native as the debugging
platform.

x64 Select this checkbox if you are debugging
a 64 bit application.

Deselect the checkbox 1f you are
debugging a 32 bit application.

Mode Select the Run radio button.
Default This is set as the default directory for the
Directory process being debugged.

Application Select and enter either the full or the
Path relative path to the application
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executable.

. If the path contains spaces, specify the
full path; do not use a relative path

. If the path contains spaces, the path
must be enclosed by quotes

Command Parameters to pass to the application at

Line start up.

Arguments

Show Create a console window for the

Console debugger; not applicable for attaching to
a process.

Symbol Specify any additional paths to locate

Search Paths | debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running

Field Action

Debugger Select Microsoft Native as the debugging
platform.

(c) Sparx Systems 2023 Page 125 of 237



Build and Debug 13 November, 2023

x64 Select this checkbox i1f you are debugging
a 64 bit application.

Deselect the checkbox i1f you are
debugging a 32 bit application.

Mode Select the Attach to Process radio button.

Symbol Specify any additional paths to locate
Search Paths | debug symbols for the debugger.

You could specify a symbol server here if
you prefer; separate the paths with a
semi-colon or comma.
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Debug Symbols

For applications built using Microsoft Platform SDK, Debug
Symbols are written to an application PDB file when the
application is built.

The Debugging Tools for Windows, an API used by the
Visual Execution Debugger, uses these symbols to present
meaningful information to Execution Analyzer controls.

These symbols can easily get out of date and cause aberrant
behavior - the debugger might highlight the wrong line of
code in the editor whilst at a breakpoint; it 1s therefore best
to ensure the application is built prior to any debugging or
recording session.

The debugger must inform the API how to reconcile
addresses in the image being debugged; it does this by
specifying a number of paths to the API that tell it where to
look for PDB files.

For system DLLs (kernel32, mfc90ud) for which no debug
symbols are found, the Call Stack shows some frames with
module names and addresses only.

You can supplement the symbols translated by passing
additional paths to the API; you pass additional symbol
paths in a semi-colon separated list in the 'Debug' tab.
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Merge Script

A Merge command in an Analyzer Script gives users an
additional command to perform some action. The merge
action 1s dependent on your requirements.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Merge' page or

. Click on & - in the window Toolbar, select the Package in
which to create a new script, and select the 'Merge' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Source > Merge

Keyboard Ctrl+Alt+M
Shortcuts
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Code Miner Script

The Code Miner system uses a set of databases to provide
fast and comprehensive access to information derived from
existing source code. The Intelli-sense features of Enterprise
Architect's code editors and its search tools can make use of
the information mined from these databases.

Through the Code Miner script pages, you can specify
which Code Miner databases to use with a particular project
and you can create, update and add new databases to the
Code Miner library. The 'Services' page allows you to
specify a local Code Miner library, or that you want to
access the library available through the Sparx Intel Service.

Different Code Miner details can be specified for each
Analyzer Script, so the Code Miner libraries that are used
are determined by the active Analyzer Script.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Code Miner' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Code Miner'

page

Ribbon Execute > Tools > Analyzer > View
Analyzer Scripts > Double-click on
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Script name > Code Miner > Service

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts >
Double-click on Script name > Code
Miner > Service

Keyboard Shift+F12
Shortcuts

Sparx Intel Service

A Code Miner Library can be used locally, or it can be
deployed to a server location where it can service multiple
clients. You select the scenario to use on the 'Code Miner
Service' page of the Analyzer Script.

Merge -
Changes Code Miner Service:

History )

Cormmit ® Use Library

ST S Usze Server Haost : Port Macro

Repositary

4 Code Miner 0 HINTELHOST#
Service
Libraries

4 Private Options
Services

4 Job Settings Limit Query Results to: 0 -

Motifications

Run Code Miner databases provides support to Enterprize Architect intelizense, metrics and zearch tools.

Y'ou can chooze between a local librarw or server.
Deploy

Recording
Sirmulation

Run JavaScript

Code Miner Libraries
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The Code Miner Database Libraries are a collection of
databases containing information derived from source code.
Together, these databases form the Code Miner Library used
by the Intelli-sense features of Enterprise Architect.

Usually, a library would be created for each framework or
project. The Code Miner Libraries page allows new
databases to be created, and existing databases to be added,
updated or removed from a library.

Code Miner Query Libraries are a collection of functions,
written in Code Miner's mFQL language, bundled together
into one source file.

The Code Miner Database Library and Query Library for a
given Analyzer Script are specified on the 'Code Miner |
Libraries' page of the Script Editor.

Execution Analyzer: Exchanger.debug. jdwp

Bl B:'-'”d Code Miner Database Library

i Build

i Clean New

B Test

i TSt Library Path Language  Source Recursive
Testpoints E\java\jdk-1.8.0_31\java)DK.cdb Java E\javaljdk-1.8.0_31\src\  True

B Debug E\cladonia-dst\exchanger.cdb Java E\cladonia-dst\exchan... True

Platform E\java\gwt-2.8.cdb Java E\java\gwt-2.8. 1\samples\ True

i DebugRun
Tracepoints
. Warkbench
[ Code Miner
service
. Libraries
[=]- Private Options

.. Services F 4
- Run ' ) '
- Deploy Code Miner Query Library
- Recording
- Simulation
- Merge

e\javalsparx-queries mfgl

Cancel Help
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Services Script

The 'Services' page of an Analyzer Script describes the
default ports used when scripts are created by various Visual
Execution Analyzer functions (Import project, Generate
Executable StateMachine). You can update any of the Port
specifications on this page.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Private Options | Services' page or

. Click on ¥ - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Private
Options | Services' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts
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Run Script

This section describes how to create a command for running
your executable code.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Run' page or

. Click on ¥ - in the window Toolbar, select the Package in
which to create a new script, and select the 'Run' page

Ribbon Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Ctrl+Alt+N
Shortcuts

Script elements

Element Description

Command This 1s the command that 1s executed
when you select the 'Execute > Run >
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Start' ribbon option; at its simplest, the
script would contain the location and
name of the file to be run.

Examples These two examples show scripts
configured to run a .Net and a Java
application in Enterprise Architect.

.Net:

C:\benchmark\cpp\example net 1\release
\example.exe

Java:
customer

The command listed in this field 1s
executed as if from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
enclosed by quotes.

Notes

. Enterprise Architect provides the ability to start your
application normally OR with debugging from the same
script; the 'Analyzer' menu has separate options for
starting a normal run and a debug run
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Deploy Script

These sections explain how to create a command script for
deploying the current Package. The script can be executed
by selecting the 'Execute > Source > Build > Deploy' ribbon
option or by pressing Ctrl+Shift+Alt+F12.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Deploy' page or

. Click on & - in the window Toolbar, select the Package in
which to create a new script, and select the 'Deploy' page

Ribbon Develop > Source Code > Execution

Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard Ctrl+Shift+Alt+F12
Shortcuts

Actions

Action Detail

(c) Sparx Systems 2023 Page 135 of 237



Build and Debug 13 November, 2023

Execute Process

Command as: ' If the deployment is handled externally,
enter the path to the program or batch file
to run, followed by any parameters; the
program is launched in a separate
process.

Example:

C:\apache-ant-1.7.1\bin\ant.cmd
myproject deploy

Batch File

When using this option, you can enter
multiple commands that are then
executed as a single script in a command
console; you have access to any
environment variables available in a
standard command console.

Example:
@echo on

IF NOT EXIST "%1%" GOTO
DEPLOY NOWAR

IF "% APACHE HOME%" == ""
GOTO DEPLOY NOAPACHE

xcopy /L "%1%"
"% APACHE HOME%\webapps"

GOTO DEPLOY_END
rem
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rem NO WAR FILE

rem

:DEPLOY NOWAR

echo "%1% WAR file not found"
GOTO DEPLOY END

rem

rem NO APACHE ENVIRONMENT
VARIABLE

rem
:DEPLOY NOAPACHE

echo "APACHE HOME environment
variable not found"

:DEPLOY END
pause

Parse Output = Selecting a Parser from the list causes
output of the deploy script to be captured;
the output 1s parsed according to the
syntax selected from the list.

To display the System Output window,
select the 'Start > All Windows > Design
> Explore > System' ribbon option.

(c) Sparx Systems 2023 Page 137 of 237



Build and Debug 13 November, 2023

Recording Scripts

The beauty of recording is not really that we always get to
see the bigger picture, but a chance to see a smaller picture
that has some truth to tell. We have all seen Sequence
diagrams that are less than helpful. (The same message
appearing 100 times in succession on a diagram does tell us
something, but not much.) Fortunately Enterprise Architect
takes care of this first point through the use of fragments.
Repeating behaviors are identified as Patterns and
represented once as a fragment on the Sequence diagram.
The fragment 1s labeled according to the number of
iterations. The recording history, of course, always shows
the entire history. We also need tools to help us focus the
recording on particular areas of interest and reduce the noise
from others. We can use filters to do this. With filters, you
can exclude any Classes, functions, or even modules from
any recording. You can create multiple sets of filters and use
them with marker sets to target different Use Cases.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Recording' page or

. Click on ¥ - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Recording’

page
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Ribbon

Keyboard
Shortcuts

Filter Strings

Element

Filtering
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Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Shift+F12

Discussion

If the 'Enable Filter' checkbox 1s selected
on the 'Recording' page of the Execution
Analyzer Script Editor, the debugger
excludes calls to matching methods from
the recording. The comparison is
case-sensitive.

To add a value, click on the 'New'
('Insert') icon in the right corner of the
'Exclusion Filters' box, and type in the
comparison string; each filter string takes
the form:

class_name token::method name token

The class name token excludes calls to
all methods of a Class or Classes that
have a name matching the token; the
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string can contain the wildcard character
* (asterisk).

The method name token excludes calls
to methods having a name that matches
the token; again, the string can contain
the wildcard character *.

Both tokens are optional; 1f no Class
token 1s present, the filter is applied only
to global or public functions (that is,
methods not belonging to any Class).

In this Java example, the debugger would
exclude:

. Calls to the OnDraw method for the

Class
Example.common.draw.DrawPane

. Calls to any method of any Class
having a name beginning with
Example.source.Collection

. Calls to any constructor for any Class
(such as <clint> and <init>)

Filters

Example.commaon. draw. DrawPane: : OnDraw
Example.source. Collection™
Finit™

In this Native Code example, the
debugger would exclude:

. Calls made to Standard Template
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Filters

Use Filter
Entry

- Get*

*..Get*

CClass::Get*
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Library namespace
. Calls to any Class beginning with TOb
. Calls to any method of Class CLock

. Calls to the method GetLocation for
Class CTrain

. Calls to any Global or Public Function
with a name beginning with Get

Filters

std*

TOb*

Clock
CTrain::GetLocation
fnGet®

To Filter

All public functions having a name
beginning with 'Get' from the recording
session (for example, GetClientRect in
Windows API).

All methods beginning with 'Get' in any
Class.

All methods beginning with Get for the
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CClass Class.

CClass::* All methods for CClass Class.

ATL* All methods for Classes belonging to
std* Standard Template and Active Template
Libraries.

CClass::GetN ' The specific method(s) GetName for the
ame CClass Class.
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The Job Queue Window

The Job Queue window streamlines the process of working
with Analyzer Scripts, which originally were worked on
individually and if no other script was being executed. In
versions of Enterprise Architect from Release 16.0 onwards,
when an Analyzer Script context menu option 1s executed
(for example, 'Build') it 1s placed in a job queue; multiple
jobs can be queued, and other work performed while the
jobs are processed.

The name of the Analyzer Script is used as the name of the
job. An Analyzer Script can have multiple sections, such as
Build, Test, Run and Deploy, and each section is assigned as
a task of the job.

Job Queue v &x
m 4+ + X |1 3

Mame Task Status | Erro... | Completed Host

! Simulation.State...  Build Failed 1 6/09/2021 2:30:...

# (ClassLibrary Build OK 6/09/2021 2:30:...

¥ CityLoop Build OK 6/09/2021 2:30:...

+ BookTest Build OK bf03/2021 2:15:...

! DMN Module Com... Build Failed 1 6/09/2021 2:15:...

The output from each job executed from the Job Queue
window is captured to the 'Job History' tab in the System
Output window.

Access

Ribbon Execute > Tools > Analyzer > View Job
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Queue

Start > All Windows > Design > Explore
> System > Job History

Job Queue Columns

Column Description

Name The name of the Analyzer Script for
which the job has been added to the Job
Queue. If the job has been executed, the
name will have a tick(for successful
completion) or exclamation mark (for
failure) in front of it.

Task The section of the Analyzer Script that
the job is executing - for example, Build
or Deploy.

Status The completion status of the job -

whether the job completed successfully
('OK") or failed.

Errors If the job has been executed and failed,
the number of errors that arose.

The date and time at which the job
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Completed completed.

Host If the job is run remotely, the IP address
or host name of the remote machine.

Recvd If the job 1s run remotely, any return
message from the host machine.

Context Menu Options

Right-click on a job name, or on the background of the
window, to display the 'Job Queue' context menu.

Job Queue
oo LS
Mame Task Status Erro...
ed Actionpoint tests...  |avaScript _
View Log
Cancel Job
4
Execution Analyzer | Job Queue
Option Description

View Log Select this option to display the 'Job
History' tab of the System Output
window, for a job that has been executed.

Cancel Job Right-click on a job name and click on
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this option, as necessary and at any time,
to cancel the selected JavaScript task.

The cancellation is indicated in the Job
Queue window by a 'no entry' icon next
to the job name.

Job Queue v
o x (1 3

Name Task Status Erro... Completed

@ Actionpoint tests...  JavaScript Cancelled B8/039/2021 11:23...

4
Execution Analyzer | Job Queue

In the 'Job History' tab of the System
Output window, the output 1s terminated
with a 'Script Cancelled' message.

System Output

System  Job History  Script  JsonlLDExport

Actionpoint tests xb4

Templates
Factions
GameState
Messages
Items
Weapons
Messaging
Script cancelled

Delete Job Click on a job that has not yet started and

select this option to remove it from the
Job Queue.

Select this option to execute the selected
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Re-Run Job | completed job again.

Re-Run (Ctrl+click on a number of required jobs.)
Selected Jobs | Select this option to execute all the
selected completed jobs again.

Re-Run Select this option to execute all the
Completed completed jobs in the current list again.
Jobs

The Job History Tab

The output from each job executed from the Job Queue
window 1s captured to the 'Job History' tab in the System
Output window. From there, any job log can be viewed at
your discretion, by selecting it from the drop-down list in
the toolbar. If the job has failed and there are error
messages, you can skip from message to message using the
red arrow 1cons. These icons are disabled if there are no
active error messages.
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System Qutput

Systemm  Job History  Script  JsonLDExport

Actionpoint tests x64 -

1>—r- Build started: Project: ActionPoints, Configuration: Debug x64 -——---
1=stdafx.cpp

1>ActionPoints.cpp

1=ActionPoints.voxproj -=> C:\EA\Stephen\ActionPoints\x64\Debug\ActionPoints.exe
========== Build: 1 succeeded, 0 failed, 0 up-to-date, 0 skipped ==========
process ended, exitcode 0

Completed Build section

Build succeeded

Started Deploy section

Executing script on remote host 192.168.20.9:9000

Connecting to 192.168.20.9:3000...

Connected.

Job Queue Toolbar Options

Option Description

" Click on a job name and click on this
icon to pause or resume the selected job.

Click on a job name and on one of these
two arrows to move the job up or down in
the job queue, making it earlier or later in
the order of processing.

* Click on a job name for a job that has not
yet started, and on this icon to delete that
job from the Job Queue window.
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Lo Click on the up or down arrow to set the
number of jobs that can run concurrently,
up to a maximum of 8.

The count defaults to 1 so that the Job
Queue will process jobs one at a time,
First In First Out.
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Build Application

This topic explains how to execute a Build script on your
application, within Enterprise Architect.

Access

Ribbon Execute > Source > Build > Build

Keyboard Ctrl+Shift+F12

Shortcuts
Other 'Build' toolbar > &
Execution Analyzer window | &
Action

When you select the 'Build' option, it executes the 'Build'
command 1n the script selected in the Execution Analyzer
window. The progress and outcome of the build operation
are displayed in the 'Build' tab of the System Output
window.

You can quickly visit the line of code for any compilation
error appearing by double-clicking the error.
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Locate Compiler Errors in Code

When you build an application using an Analyzer Script,
compiler output is logged in the System Output window.
You can double-click on any error message that appears
here and be taken to the source code. When you do, the
cursor 1s positioned on the line containing the error.

a8l
62 if{PeopleOFF > 8)
63 re turn PeopleOFF * 20;

B4
B85 return @;
1
Output
Py e e

58| Running Analyzer Script - CityLoop

G50 Microsoft (R) Visual Studio Version 10.0.30319.1.

76 Copyright (C) Microsoft Corp. All rights reserved.

1-mmee- Build started: Project: CityLoop, Configuration: Debug Win32 ------

72| 1> Train.cpp

y 241> cdata\wea\microsoft native\citylooptrain.cpp(63): error C2065: 're' : undeclared identifier

7% 1=chdata\weahmicrosoft nativehcityloop\train.cpp(63): error C2146: syntax error : missing ;' before identifier 'turn’
78] 1> c\data\wea\microsoft native\cityloop\train.cpp(63): error C2065: "turn’ : undeclared identifier

Tip

If output 1s missing, check that a language parser is
mentioned in the Analyzer Script (Shift+F12).

Parse Output: Java SDK -

Access

Ribbon Start > All Windows > Design > Explore
> System
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Keyboard Ctrl+-Shift+8
Shortcuts
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Debugging

provides every feature that you might expect in an IDE.
Comprehensive debugging environments and tools for many
major platforms are made available. Integrating the
debugging capability within the modeling tool allows code
to be developed, built and managed by its authors. Working
and collaborating in an integrated model has made actions
count and every action accountable in ways that are just not
possible using other tool chains.

Features

Speed

Debuggers in Enterprise Architect are quick! Stepping
through programs will not take all day.
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The Recording program can be executed without manual
stepping.

Support

. C++, C and Visual Basic

. Microsoft NET, ASP.NET WCF

. Java, using socket transport (JDWP) or in memory model
(JVMIT)

. Android on an emulator or device
. JavaScript, VBScript and JScript
. PHP scripts on Apache web servers

. Remote Linux GDB processes using Enterprise Architect
on Windows

. Simulation - debug simulations in UML and BPMN

. Executable StateMachines - debug an executing
StateMachine

Isolation

The debuggers operate out-of-process from Enterprise
Architect, 1solating it from side effects.

Efficiency

Starting and stopping the debugger 1s quick and painless. It
does not hold you back. Designed to be a responsive UI, the
main UI thread is isolated from duties that are not its
responsibility.

Productivity

Switch from modeling to requirements, from raising a
change request to tracking code changes in a model shared
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across an organization, to profiling recent code changes. All
in the one tool.

Notes

. The debug and record features of the Visual Execution
Analyzer are not available for the Java server platform
'Weblogic' from Oracle
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Run the Debugger

Enterprise Architect provides a number of ways to start and
control a debug session. There 1s the main Debug window,
as well as a Debug toolbar and the 'Run' panel in the
'Execute’ ribbon. It is always best to display the Debug
window whenever you are running a debug session, as this
is where all debug output is captured.

Access

Ribbon Execute > Run > Start
Execute > Tools > Debugger > Start
Debugging

Keyboard Alt+8 (displays the Debug window)

Shortcuts F6 (begins execution of the
application being debugged)

Toolbar Explore > Portals > Show Toolbar >

Debug

Using the Debug window

Action Detail
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When an Analyzer script has been
configured to support debugging, you can
start the debugger in these ways:

. From the ribbon, select 'Execute > Run
> Start > Run'

. From the ribbon, select 'Execute >
Tools > Debugger > Start Debugging'

. On the 'Debug' toolbar, click on the
button, or

. Press F6

You can also launch the debugger for any
script through its context menu in the

'Analyzer Script Window', or press
Shift+F12

If you have no Analyzer Script, it is still
possible to debug a running application
by attaching to that process directly:

. From the ribbon, select 'Execute >
Tools > Debugger > Attach to Process',
or

. On the 'Debug' toolbar, click on the #
(Attach) button and choose the
debugging platform manually

You can pause a debugging session, or
resume the session after pausing, in these
ways:
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. From the ribbon, select 'Execute > Run
> Pause'

. On the 'Debug' toolbar, click on the
button

The debugger normally ends when the
current debug process terminates;
however, some applications and services
(such as Java Virtual Machine) might
require the debugger to be manually
stopped. To stop debugging, either:

. On the 'Debug' toolbar, click on the
(Stop) button

. Press Ctrl+Alt+F6

. Select the drop-down arrow on the
'Execute > Run > Stop' ribbon option

The ribbon option displays a short menu
providing three ways to terminate
debugging the application.

Stop COpen

Stop
Detach
Quit Application

. Stop - stops the Debugger and stops the
process that 1s being debugged (the
default when you just click on the
ribbon icon)
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. Detach - stops the Debugger but leaves
the process running

. Quit Application - stops the Debugger
and posts a WM_ QUIT message to the
main window of the process, if it has
one

To step over the next line of code:

. From the ribbon, select 'Execute > Run
> Step Over', or

. On the 'Debug' toolbar, click on the
(Step Over) button, or

. Press Alt+F6

To step into a function call:

. From the ribbon, select 'Execute > Run
> Step In', or

. On the 'Debug' toolbar, click on the
(Step In) button, or

. Press Shift+F6

If no source is available for the target
function then the Debugger returns
immediately to the caller.

To step out of a function:

. From the ribbon, select 'Execute > Run
> Step Out'
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. On the 'Debug' toolbar, click on the [*z
(Step Out) button, or

. Press Ctrl+F6

If the debugger steps out into a function
with no source code, it will continue to
step out until a point is found that has
source code.

While the Debugger is paused, to return
to the source file and line of code that the
Debugger is about to execute:

. From the ribbon, select 'Execute > Run
> Start > Show Execution Point'

. On the 'Debug' toolbar, click on the ~
(Show Execution Point) button.

The appropriate line 1s highlighted, with a
pink arrow in the left margin of the
screen.

During a debug session, messages display
in the Debug window detailing:

. Startup of session

. Termination of session
. Exceptions

. Errors

. Trace messages, such as those output
using Java System.out or NET
System.Diagnostics.Debug
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If you double-click on a debug message,

either:

. A pop-up displays with more complete
message text, or

. If there has been a memory leak, the

file 1s displayed at the point at which
the error occurred

Save Output | You can save the entire contents of the

(and Clear Debug output to an external .txt file, or

Output) you can save selected lines from the
output to the Enterprise Architect
clipboard.

To save all of the output to file, click on
the 18 (Save output to file) button.

To save selected lines to the clipboard,
right-click on the selection and select the
'Copy Selected to Clipboard' option.

When you have saved the output or
otherwise do not want to display it any
more, right-click on the current output
and select the 'Clear Results' option.

Switch to If you are running a debug session on
Profiler code, you can stop the debug session and
immediately switch to a Profiling session.

To switch from the Debugger to the
Profiler:
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. From the ribbon, select 'Execute >
Tools > Debugger > Switch to Profiler’
. On the Debug window, click on the
' # | | Switch to Profiler' option, or
. On the Debug toolbar, click on the ' #
| Switch to Profiler' option
The Profiler attaches to the
currently-running process.

This facility 1s not available for the Java
debuggers.
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Breakpoint and Marker Management

Breakpoints work in Enterprise Architect in the same way as
in any other Debugger. Markers are similar to breakpoints,
but in Enterprise Architect they have special powers. Simply
put, markers perform actions - such as recording execution
and analysis - that breakpoints do not. The action of a
breakpoint 1s always to stop the program.

You set any marker or breakpoint in the Source Code editor,
where they are visible in the left margin. Clicking in this
margin will add a breakpoint at that line. Breakpoints and
markers are interchangeable - you can change a breakpoint
into a marker and vice versa, using its 'Properties' dialog.
You can quickly view and edit a breakpoint or marker's
properties using Ctrl+click either on its icon in the editor
margin or in the Breakpoints and Markers window.

Breakpoints are maintained in sets. There is a default set for
ecach model and each breakpoint typically resides there, but
you can save the current breakpoint configuration as a
named set, create a new set and switch between them.
Breakpoint sets are shared; that is, they are available to the
model community. The exception is the Default set which 1s
a private and personal set allocated to each user of any
model.

Access
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Ribbon Execute > Windows > Breakpoints

Simulate > Dynamic Simulation >
Breakpoints

Breakpoint and Marker Options

Option Detail

Delete a To delete a specific breakpoint:
breakpoint or . If the breakpoint is enabled, click on
marker the red breakpoint circle in the left

margin of the Source Code Editor, or

. Right-click on the breakpoint or marker
1n the Source Code Editor, the
Breakpoints folder or the Breakpoints
& Markers window and select the
'Delete' option, or

. Select the breakpoint in the 'Debug
Breakpoints' tab and press the Delete
key

Delete all Click on the Delete all breakpoints button
breakpoints ().

Breakpoint In the Breakpoints window or code
properties editor, use the marker's context menu to
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bring up the properties. Here you can
change the marker type, add or modify
constraints and enter trace statements.
(Useful shortcut: hold the Ctrl key while
clicking the marker, to quickly show its
properties.)

Deselect the checkbox against the
breakpoint or marker.

Select the checkbox against the
breakpoint or marker.

Click on the 2 button

Click on the Enable all breakpoints
button (12).

Click on the Data breakpoint button ().

Check the oefaut - field in the
Breakpoints & Events window toolbar.

If necessary, click on the drop down
arrow and select a different marker set.
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The Default set 1s normally used for
debugging and 1s personal to your user
ID; other marker sets are shared between
all users within the model.

The breakpoints and markers can be
grouped by Class or by code file. To
group the items, click on the down arrow
on the © - icon in the toolbar, and click

on the on the appropriate option. If you do not
Breakpoints | want to group the items, click on the
& Events selected option to deselect it; the
window breakpoints and markers are then listed
by line number.
Breakpoint States
State Remarks
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Debug Running: Bound
Debug Not Running: Enabled

Debug Running: Disabled
Debug Not Running: Disabled

Debug Running: Not bound - this usually
means that a module is yet to be loaded.
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Also, dlls are unloaded from time to time.
Debug Not Running: N/a

Debug Running: Failed - this means the
debugger was unable to a match this line
of code to an instruction in any of the
loaded modules. Perhaps the source is
from another project or the project
configuration is out of date. Note, that if
the module date 1s earlier than the
breakpoint's source code date you will see
a notification in the debugger window.
The text 1s red in color so they will stand
out. This is clear sign that the project
requires building.

Debug Not Running: N/a
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Setting Code Breakpoints

Normal Breakpoints are typically set on a line of source
code. When the Debugger hits the indicated line during
normal execution, the Debugger halts execution and
displays the local variables, call stack, threads and other
run-time information.

Set a breakpoint on a line of code

Ste Action
p

1 | Open the source code to debug in the integrated
source code editor.

2 | Find the appropriate code line and click in the left
margin column - a solid red circle in the margin
indicates that a breakpoint has been set at that
position.

2 CTest::CTe=st (LPCTSTER name, TTe=stType type)

124
1}5 14 T m Name = name;
15

m Type = type;

la theTest = this;

If the code is currently halted at a breakpoint, that
point is indicated by a blue arrow next to the marker.
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& int tmain(int argc, _TCHAR* argv[])
{
L g8 CTest Test( T ("Model™), CTeszt::Regression):
g return Test.Run() ;

Alternatively, you can set the Breakpoint marker (or
other marker) by right-clicking on the left margin on
the required line, to display the breakpoint/marker
context menu; select the appropriate marker type.
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Trace Statements

A Trace Statement 1s a message that is output during
execution of a debug session. Trace statements can be
defined in Enterprise Architect without requiring any
changes to your application source code.

Tracepoint Markers are set in the code editor. Like
breakpoints, they are placed on a line of code. When that
line of code executes, the debugger evaluates the statement,
the result of which 1s logged to the Debug window (or to file
if overridden by the Analyzer script).

Access

Any existing Trace statements can be viewed and managed
in the Breakpoints & Markers window. The Breakpoints &
Markers window can be displayed using either of the
methods outlined here.

Ribbon Execute > Windows > Breakpoints

Add a Tracepoint Marker

Ste Action
p

Open the source code to debug in the source code
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1

editor.

Find the appropriate code line, right-click in the left
margin and select the 'Add Tracepoint Marker'
option.

If a marker 1s already there, press Ctrl+click to show
the Breakpoint Properties window.

Ensure the 'Trace statement' checkbox is selected.

In the text field under the 'Trace statement'
checkbox, type the required Trace statement.

Click on the OK button. A Tracepoint Marker is
shown in the left margin of the code editor.

55 DWORD CTrain::Disembark{int PeopleOFF)
56 {

[+ ] 57 if(Passengers - PeopleOFF > -1)
: 58 Passengers -= PeopleOFF;

59 else

68 Passengers = @;

6l

62 if(PeopleOFF > B)

63 return PeopleOFF * 28;

Gl

65 return 8;

66 }

Specifying a Trace Statement

A trace statement can be any freeform text. The value of any
variables currently in scope can also be included 1n a trace
statement by prefixing the variable name with a special
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token.
The available tokens are:
. $ - when the variable is to be interpreted as a string

. (@ - when the variable 1s a primitive type (int, double,
char)

Using our example in the image, we could output the
number of people getting off a train by using this statement:

There were @Passengers before @PeopleOFF got off the
train at $Arriving.Name Station

In addition to tracing the values of variables from your code,
you can use the $stack and $frame keywords in your Trace
statement to print the current stack trace; use:

. $stack - to print all frames, or

. $frame[start](count) - print a specific number of frames
from the stack starting at a given frame; for example,
$frame[0](5) will print the current frame and 4 ancestors

Notes

. Trace statements can be included on any type of
breakpoint or marker.
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Break When a Variable Changes Value

Data breakpoints can be set on a pre-determined memory
variable to cause the debugger to halt execution at the line
of code that has just caused the value of the variable to
change. This can be useful when trying to track down the
point at which a variable 1s modified during program
execution, especially if it 1s not clear how program
execution is affecting a particular object state.

Access

Ribbon Execute > Windows > Local Variables :
Right-click on variable > Break When
Variable is Modified or

Execute > Windows > Watches :
Right-click on variable > Break When
Variable 1s Modified

Other In a code editor window: Right-click on
the variable of interest | Break when item

modified

Capture changes to a variable using data
breakpoints
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Ste Detail
ps

1 | Set a normal breakpoint in the code so you can
choose a variable. Then run the debugger (F6).

2 | When the program has hit the breakpoint, select the
variable of interest and from its context menu, select
the 'Break When Variable is Modified' option.

Locals o ox
Yariable Value
24 this 0x008efel10
Iél--v CTrain
H-¢ TObject
®-¢ h_thread 00000000
- m_tid 2864
W4 Network 00012F78¢
®-¢ Arriving 05008 efdad
-4 Distance 0.000000
.. Capacity 500
g Mumbe Break When Vanable is Modified Ib
-4 Departi View Memory at Address
% Locatia i in Editer
-4 Delay . .
¢ PeopleON Dump Variable Members to File
. Save Snapshot of Variable -

Compare Variable Snapshots
| Watches |3 Local P P

LR F U

3 | There are no breakpoint indicators in the code, but
data breakpoints are easily recognizable in the
Breakpoints & Events window, being a blue icon
with a white diamond. Enterprise Architect displays
the name of the variable and its address instead of a
line number.
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BrEakpUiﬂtS & Markers o e e L P E P Ee P R B B B B

iy @ @y 8 2 [Default 2-8-@
Enabled Line Source

D M0ZEBEE4 int Passengers (002BBEE4)

» O 127 CHEANEATREINCode Samples ' VEAND

4 | With the data breakpoint set, you can disable any
other breakpoints you might have. The program will
stop at any line of code that changes this variable's
value. Now run your program.

5 | When this variable is modified, the debugger halts
and displays the current line of code in the editor.
This is not the line that caused the break, but the line
of code following the event. The event is logged to

the Debug window.
#- ¢ ) n(EEaa ¢ W@

[1650154916] Module loaded C:AWindows\SysWOWES\ole32.dIl no symbols

[1650154916] Module loaded CAWindows\SysWOWENSHCORE.dIl no symbols

[1650205565] Data breakpoint hit at CTrain.Disembark, c\ea\ea?30"code samplesivea\microsoft native\cityloop'y
[1650270313] Data breakpoint hit at CTrain.Embark, chea\ea730\code samples\vea\microsoft nativel\cityloop'trai
[16530271852] Data breakpoint hit at CTrain.Disemnbark, chea\ea73 M code samplesivea\microsoft nativelcityloop'
[1650272025] Data breakpoint hit at CTrain.Embark, c\ea\ea750\code samples\vea\microsoft native\cityloop'trai
[1630273270] Data breakpeint hit at CTrain.Disemnbark, chea\ea73 0 code samples\vea\microsoft nativecityloop'
[1650273521]  Data breakpoint hit at CTrain.Embark, c\ea\ea73 0 code samplesivea\microsoft nativelcityloophtrai
[1650274759]  Data breakpeint hit at CTrain.Disembark, c\ea\ea?30code samplesiveaimicrosoft nativelcitylooply
1

# Debug | | Execution Analyzer

Now we know how and where this value (its State)
has changed. For example, the statement at line 58
has just updated the number of Passengers.
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55 DWORD CTrain::Disembark({int PeopleOFF)

56 {

57 if(Passengers - PeopleOFF » -1)
58 Passengers -= PeopleOFF;
59 else

a8 Passengers = @j

61

62 if(PeopleQFF > @)

63 return PeopleQFF * 28;
(]

65 return @j

66 }

6 | Having discovered this and other places where this
value 1s being changed, be sure to get rid of the
notification before moving on. You can delete the
data breakpoint quickly by selecting it in the
Breakpoints window and pressing the Delete key.

You can also use the right-click context menu to do

this.
A 4y 4y 8 T Default A=
Enabled Line Source
BRI e e
y O emove Break a ress He Sam
' O View Memory at Address de Sam|
O el de Sam|
O e de Sam|
O i} CHAEANEATHINCode Sam)

. This feature is not presently supported by the Microsoft
NET platform
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Trace When Variable Changes Value

When your code executes, it might change the value of a
variable. It is possible to capture such changes and the
variable's new value, on the Debug window. You can then
double-click on the change record to display the line of code
that caused the change, in the Code Editor.

Access

Ribbon Execute > Windows > Local Variables :
Right-click on variable > Trace When
Variable 1s Modified or

Execute > Windows > Watches :
Right-click on variable > Trace When
Variable 1s Modified

Other In Code Editor | Right-click on variable |
Trace When Variable Modified

Set up Trace

The variable you are tracing must be in scope, so to identify
and select it, set a normal breakpoint on the line of code
where you know that the variable will exist. When the
debugger reaches this breakpoint, locate the variable and use
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1ts context menu to enable the trace.
To locate a variable:

. If you see the variable in the source code, hover over it,
right-click and select the 'Display variable' option;
Enterprise Architect will locate it

. If the variable 1s in scope (a local, or 'this' or a member of
'this'), look for 1t in the Locals Window ('Execute >
Windows > Local Variables')

. If'the variable is global (C, C++), display the Watches
window ('Execute > Windows > Watches') and search for
it by name

. If the variable is a Class static member, display the
Watches window ('Execute > Windows > Watches') and
enter its fully qualified name

Once trace 1s enabled, you can disable all other breakpoints
and let the program run. Each time the variable changes
value, it will be logged to the 'Output' tab of the debugger.
Check the change in value and double-click on the line to
display the code in the Code Editor.

Notes

. The debugger does not halt when the change event occurs,
it only logs the change

. This facility is available on the Microsoft Native and Java
platforms

. Microsoft .NET does not support breakpoints on values
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Detecting Memory Address Operations

Being able to detect where and when an area of memory is
being read or written can be a great help for investigators,
even when the code base 1s well understood. Without this
tool, a C++ developer could have a potentially daunting task
of tracking where and when a global variable 1s accessed,
and debugging those functions. Data breakpoints allow a
C++ programmer to track when a variable / memory
location is read or when it 1s written. When the operation is
detected, the debugger will halt the execution and the line of
code following the operation will be displayed in the code
editor.

Access

Ribbon Execute > Windows > Breakpoints

Detect operation on memory address

Ste | Action
Y

1 Click the ¢ button.
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2 | Enter the memory address to watch. You can copy
an address from the Locals (Local Variables)
window.

Data Eit?a kpoint
Address: (e0033Fdf4

Operation: Write Action: Break

Read [ Write Trace

0K Cancel

3 | Select the operation to detect. If you select "Write',
the debugger will break when the address is written
to. If you choose 'Read / Write', the debugger will
notify you when the address is read or when it is
written.

4  Select the action to perform. If you choose 'Break’,
the debugger will halt the program and the line of
code will be shown in the editor. If you choose
"Trace', the debugger will not halt execution, but log
any operation on the address as it occurs. This output
1s displayed in the Debugger Window.

5 | The data breakpoint is added to the Breakpoints and
Markers window.
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Breakpoints & Markers

@ AN < | MyBreakpoints - B~ H- ':@'
Enabled Line Source
L) O033FDF4 (NN3I3ENF4

Remove Break at Address

Viﬁv Memory at Address

Help

6 | You can use the context menu on the data breakpoint
to check the value at the memory address.

Memory Viewer

(33fdf4 Q @:l
0x0033FDF4 01 00 00 00 00 00 00 O0 00 00 00 00 00 00 00 00 CCCCCC
0x0033FEDY CCHBFE 330018 1D 41000100 00 00 AS 14 42 00 AB43
0x0033FE1A 42 00 F9 97 04 A7 82 10 41 00 00 FO FD 7F 00 FO 63 7B 28
0x0033FE2D 2D 4100 256 AE44 7B 00 00 00 00 00 00 34 00 00 00 00 00

7 | To delete a data breakpoint, select it in the
Breakpoints and Markers window and press the
Delete key. Alternatively, deselect the checkbox next
to it. Data breakpoints are deleted when they are
disabled; they do not persist as other breakpoints do.

System Requirements

Memory address breakpoints are supported in the C/C++
native debugger.
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Breakpoint Properties

Breakpoints have a number of additional properties that
determine what occurs when executing the line of code that
the breakpoint applies to.

These properties define:
. The action to be performed
. The line of code that the breakpoint applies to

. Constraints that determine whether or not the action is
performed when the breakpoint is hit

. Trace information to be output when the breakpoint is hit

Ereakpoint Properties x
Action: Line number:
@ Break Execution - 62

| Constraints:

h_secClosingVolume < 0

.| Trace statement

Clasing Volume @m_secClosingVolume is Megative 11

Cancel Help

Access

There are several ways to display the 'Breakpoint Properties'
dialog:
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Code Editor | . Right-click on a breakpoint marker |
Properties or

. Ctrl+Click on breakpoint marker or

. Right-click on code that has a
breakpoint marker | Breakpoint |
Properties

Breakpoints | . Right-click on breakpoint | Properties
& Markers

window

Options

Field Details
Action The behavior when the breakpoint 1s hit.
Line The line of source code that this

breakpoint applies to.

Stack Height = For Stack Capture markers, the number of
caller frames to record. To record the
entire Stack, set the value to 0.

Constraints Defines the condition under which the
breakpoint action will be taken. For

(c) Sparx Systems 2023 Page 184 of 237



Build and Debug 13 November, 2023

normal breakpoints this would be the
condition that halts execution. In this
example, for a normal breakpoint,
execution would stop at this line when
the condition evaluates to True.
Constraints are evaluated each time the
line of code is executed.

(this.m_FirstName="Joe") AND
(this.m_LastName="Smith")

Trace A message output to the Debug window

statement when the breakpoint is hit. Variables
currently in scope can be included in a
trace statement output by prefixing the
variable name with a $ token for string
variables, or an (@ token for primitive
types such as int or long. For example:

Account $pAccount->m sName has a
balance of (@pAccount->m_{Balance
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Failure to Bind Breakpoint

A breakpoint failure occurs if there is a problem in binding
the breakpoint. Breakpoint failures are most often caused by
source files being changed without the application being
rebuilt. Breakpoints can sometimes bind to a different line,
causing them to be moved. If a breakpoint cannot be bound
to the binary at this line or the three lines following it, it is
displayed with a question mark.

A warning message displays in the 'Details' column of the
Breakpoints & Events window, identifying the type of
problem:

. The source file for the breakpoint does not match the
source file used to build the application image

. The time date stamp on the file 1s greater than that of the
image
A warning message is also output to the Debug window.
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Debug a Running Application

Rather than starting a process explicitly from within
Enterprise Architect, you might want to debug an
application (process) that 1s already running on your system.

In this case you can use the debugging capability to attach to
the process that 1s already running. Provided you have the
appropriate debug information written into the running
process, and/or associated debug files (such as .PDB files),
the debugger binds to that process and initiates a debug
session.

You can also 'detach' from the process after you have
completed your inspection and leave the process to run as
normal.

Access

Ribbon Execute > Run > Start > Attach to
Process

Debugger The debugger window toolbar has an
Window Attach button

Stages
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Stage

Show
Processes

Select
Debugger

Process
Selection
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Description

When you select to debug another
process, the 'Attach To Process' dialog
displays.

You can limit the processes displayed
using the radio buttons at the top of the
dialog; to find a service such as Apache
Tomcat or ASP.NET, select the System
radio button.

When you select a process, you might
have to choose the debugger from the
Debugger dropdown list; however, if the
selected Package has already been
configured in an Analyzer Script, then the
debugger listed in the script is preset on
the dialog.

Once you double-click on a process
containing debug information, and
Enterprise Architect is attached to the
process:

. Any breakpoints encountered are
detected by the debugger

. The process is halted when a
breakpoint is encountered, and

. The information 1s available in the
Debug window
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Detach From = To detach from a process, click on the &
Process (Debug Stop) button.
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View the Local Variables

The Locals window displays variables of the executing
system. Whether you are recording C#, debugging Java,
C++ or VBScript, debugging an Executable StateMachine,
or running a simulation, this window is where the system's
variables are located. Current values are only displayed
when a program is halted. This occurs when a breakpoint is
encountered during debugging, when you step over a line of
code or when you step between States in a simulation.

Access
Ribbon Execute > Windows > Local Variables
Simulate > Dynamic Simulation > Local
Variables
Context In Code Editor | Right-click on any
Menu variable identifier > Display Variable
Icons

The value and type of any in-scope variable 1s displayed in a
tree; each variable has a colored box icon that identifies the
type of variable:

. Blue - Object with members
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Finding variables

Green - Arrays

Pink - Elemental types
Yellow - Parameters
Red - Workbench instance

13 November, 2023

The easiest way to find a variable 1s to first locate it in the
code editor and use the right-click context menu on the
variable, selecting 'Display Variable'. Enterprise Architect
will find and reveal any variable in scope, including deeply
nested members. If the variable 1s found in a different scope
(global, file, module, static), it will be displayed in the
Watches window (see View Variables in Other Scopes).

o to Declaration

Go to Definition

synchronize Tree to Editor

Auto synchronize Tree and Editor

Search for ‘%'

Search Intelli-sense

5et Debugger to Line

Run to Cursar

Display Variable

Show in String Viewer
Break when item modified
Trace when item modified
Create Use Case for '"Run’

Ereakpoint

Persistent View
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The examination of variables usually involves digging
around in the tree to expose the values of interest. It can be
annoying then, having gone through that trouble, to step to
the next line of code, only to have those variables buried
from sight again due to a change in context. The Locals
window has a persistent view that lingers for a while after a
run or step command. When you step through a function in
Enterprise Architect, the variables structure persists line
after line. This makes stepping through a function quick and
easy.

What changed

As part of the persistent view, the Locals window tracks
changes to values and highlights them.

LONCE IS 10ttt T T e T T D D e D D D DT D DT DT e e D D DD D e DD D D DD DD D DD D D e e e D D D D D D D D
Variable Value Type Address
= § this OxD2BDOAAD Exchange:Account™  Ox00cBfed0
= § ExchangenAccount Exchange:Account Ox02bd0aal
#  Exchange:lAccount 0x02bd0aal
4 § m_pExchange 0DCBFE44 Exchange:lExchange® (x02bd0aad
3 m_acctMName "Its not broken Pty Ltd" ATL:CStringT<wchar  Ox02bd0aal8
§ m_acctBalance Dx9B8aB7T (10004599 int Ox02bd0aac
& m_acctlD 1 (1) unsigned int x02bd0abl
; sid O (2 unsigned int Ox00cBfeed
; amount OxGa (106 unsigned int Ox00cBfeed
; debitPurchaseCost Duffffec? (-318 int DxD0cEfbeld

Context Menu

Facility Detail

Break When @ Set data breakpoints on the selected
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Variable 1s
Modified

View
Memory at
Address

Show 1n
String
Viewer

Dump
Variable
Members to
File

Save
Snapshot of
Variable

Compare
Variable
Snapshots

Copy
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memory variable to halt debugger
execution at the line of code that has just
caused the value of the variable to
change.

Display the raw values in memory at the
selected address, in hex and ASCII.

Display the variable string in the 'String
Viewer' dialog.

Capture and store the selected variables
to a separate location; a browser displays
to select the appropriate .txt file name and
file path.

Capture the value of a variable at a
specific point in the life of that variable.

Compare the values of a variable at
different points in the life of that variable.

Copy the selected variable to the
Enterprise Architect clipboard.
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Add Instance = If you have opened a model diagram

Run State to  containing an Object of the Class for

Diagram which the source code 1s being debugged,
this option updates that Object with the
Run State represented by the variable

value.
Set Add a breakpoint at the current execution
Conditional | position with a constraint for this variable
Breakpoint matching its current value.
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View Content Of Long Strings

For efficiency, the Locals window only shows partial
strings. However, you can display the entire contents of a
string variable using the 'String Viewer'.

Locals
Variable Value Type Address
@ this (b2 5604 E0D CContextHandler* x0887efbd
& grammar Y AML nBMF Grammar caseSensitive(); delir - ATL:CStringT<unsign  0x0887f0b4
B ¢ data "=l version="1.0" encoding="UTF-8"?> =  ATL:CStringT<unsiqi (x0387f0ed
= & ATL:CSimpleStringT= (nc0887f0ed
= 4 m_pszData "= Teml version="1.0" encoding="UTF-8"%> < wchar* (083704
o owehar  “<hmlversion="10" encodina="UTF-8"7> < wehar  0%6c300
i macros Break When Variable is Modified ATL:CStringT<unsigr TeD887F0dc
& ret Trace When Variable is Modified bool 00857 efbf

View Memory at Address

Show in String Viewer

Dump Variable Members to File
Save Snapshot of Variable

ahle Snapshaots

Copy

Set Conditional Breakpoint

Help

This example shows the value of a variable holding the
contents of an XML schema file.
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« fusd:enumeration = -
«<wsd:enumeration value="204143">
<ysd:annotation =
<¥sd:documentation xml:lang="en"=
<ccts:Mame =Discharging chassis in overtime < focts:Name =
< fwsdidocumentation =
< fusd:annotation =
« fwsd:enumeration =
«<xsd:enumeration value="204144">
<xsd:annotation =
<xsd:documentation xml:lang="en"=
<rctsiMame =Discharging breakbulk (1 ton to 7 ton) ro—o in overtime < fccts:Mame =
< fusd:documentation
< fusd:annotation =
< fusd:enumeration =
<xsdienumeration value="204145">

Save Help
Access
From Code Right-click on string variable | Show in
Editor or String Viewer
Locals
window
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View Debug Variables in Code Editors

When a breakpoint occurs, you will see all the local
variables in that window. You can also inspect variables in
the Source Code Editor by hovering your mouse over the
reference. Here are some examples.

public woid Print ()
{

int n = 0;
while (names[n].Length = 0}

{ names = {[4] names[0]=baook, names[0]=hook, names[1]=novel, names[2]=Film}, }-|
Document d = nen Dooumerns THEmeEsS LT+ T 7

d_Printi{) ;

public woid Print ()

{
int n = 0;
whi 14 37-hit signed inkeger n=0} 0%
{

Document d = new Document (hames[n+t++]);
d.Print () ;

Note: The variable does not have to be one of the local
variables. It can have a file or module scope.
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Variable Snapshots

It 1s possible to take a 'snapshot' of a variable when your
program hits a breakpoint and use this snapshot to see how
the value of the variable changes at different points 1in its
life. The debugger does not copy the value of the selected
variable only; for complex variables it copies the values of
the selected variable and of each of its hierarchy of members
until it can no longer find any more debug information for a
member or no more members can be found.

Capture Variable Snapshot

Ste | Action
p

1 | Inthe Code Editor, set two breakpoints: one at the
start of a function and another at the end of the
function.

2 At the start breakpoint, right-click on a variable in
the Locals window and select the 'Save Variable
Snapshot' menu option.

3 Run the application.

4 | When the end breakpoint is reached, right-click on
the variable in the Locals window and select the
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'Compare Variable Snapshots' option.

A dialog displays that shows the original value from
the first snapshot and the current value from the
second snapshot as illustrated in this diagram taken
from the EA.Example model.

CTrain® this »
Mame Address Valuel Value2

int::Passengers 0x0003BEE4  Owxb1 (177) Oxds (214)

int::Delay 0x0003BEF4  0x3c (60) 0x28 (40)

Save Variable Snapshot to File

You can save the state of a variable to file using its
right-click context menu.

Break When Variable is Modified
Trace When Variable is Modified
View Memory at Address

Show in 5tring Viewer

Dump Yariable Members to File

Save Snapshot of Variable
Copy

Set Conditional Breakpoint

Help
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This 1s an excerpt of the file contents.

73 BERREEEG | Bxe8731Fe8 | name | TObjectType: :Type  |value|TypelsStation|
74 BEBEEEOS | Bx@8731F08 | name |wchar: :Name |value|"Treasury™|

75 BEEREEES | Bxe8731FEC |name|unsigned: :Location |value|ex48 (64) |

76 BEBEAEES | Bxee83BEDS | name | float: :Distance |value|@|

77 BEBREE0S | BxeBB3BEER | name|int: :Capacity |wvalue|@xlf4 (588) |

75 BEEEEEES | BxBBR3BEE4L | name|int: :Passengers |value|exde (214} |

79 BEEREEES | BxeBB3EEES |name |unsigned: tNumber  |value|@x3 (3)|

56 PEEREEES | BxeBB3BEFE |name|unsigned: :Location |value|exé (@) |

81 PEEREEES | BxeBB3EEFL |name|int: :Delay |value|B8x28 (4@) |
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Actionpoints

Actionpoints are breakpoints that can perform actions.
When a breakpoint is hit, the Actionpoint script is invoked
by the debugger, and the process continues to run.
Actionpoints are sophisticated debugging tools, and provide
expert developers with an additional command suite. With
them, a developer can alter the behavior of a function,
capture the point at which a behavior changes, and
modify/detect an object's state. To support these features,
Actionpoints can alter the value of primitive local and
member variables, can define their own
'user-defined-variables' and alter program execution.

User-Defined Variables in Actionpoints and
Breakpoints

User Defined Variables (UDVs):

. Provide the means for setting a UDV primitive or string in
Actionpoint statements

. Can be used in condition statements of multiple
markers/breakpoints

. Can be seen easily in the same Local Variables window

. The final values of all UDVs are logged when debugging
ends.

In the UDV syntax, the UDV name:
. Must be preceded by a # (hash) character
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. Is case-insensitive

Actionpoint Statements

Actionpoint statements can contain set commands, goto
commands and jmp commands.

set command

Sets variable values. An Actionpoint statement can contain
multiple 'set' commands, all of which should precede any
'g0to' command.

The 'set' command syntax is:
set LHS = RHS
Where:

. LHS = the name of the variable as a:
- user defined variable (UDV) such as #myval
- local or member variable such as strName or
this.m_strName

. RHS = the value to assign:
- As a literal or local variable
- If a literal, as one of: integer, boolean, floating point,
char or string

set command - Variable Examples

UDV
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Examples Local Variable Examples

set #mychar  set this.m nCount=0
='q'

set #mystr = set bSuccess=false
"a string"

set #myint =
10

set #myfloat
=0.5

set #mytrue =
true

goto command

This command switches execution to a different line number
in a function. An Actionpoint statement can contain only
one goto command, as the final command in the statement.

The goto command syntax 1s:
goto L
Where L 1s a line number in the current function.

The goto command uses breakpoints to achieve its goal,
which causes a slight delay in code execution. This can be
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noticeable in regions of code that are executed very
frequently, so you might prefer to use the jmp command in
such code, to achieve the same diversion of execution but
with less delay.

jmp command

The yjmp command is effectively the same as the goto
command.

jmp 125
goto 125

Both these commands cause the execution to be changed to
line 125.

However the jmp statement internally uses instrumentation
to direct the program to move execution, whereas the goto
statement uses breakpoints to do that, which causes a delay
in processing. The difference is, therefore, superior
performance for the ymp statement, especially where regions
of code are executed very frequently.

Integer operators

Where a User Defined Variable (UDV) exists and it is of
type int, it can be incremented and decremented using the
++ and -- operators. For example:

1. Create a UDV and set its value and type to a local integer
variable.
API: set #myint = nTotalSoFar
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2. Increment the UDV.
AP2: #myint++

3. Decrement the UDV.
AP3: #myint--

Timer operations

Actionpoints can report elapsed time between two points.
There 1s only one timer available, which is reset or started
with the startTimer command. The current elapsed time can
then be printed with the printTimer command. Finally, the
total elapsed time is printed and the timer ended with the
endTimer command.

Example Actionpoint Conditions

With Literals and constants:
. (#mychar="a')

. (Fmystr <>"")

. (Fmyint > 10)

. (#myfloat > 0.0)

With Local Variables:
. (#myval == this.m_strValue)
. (#myint <> this->m_nCount)

. (#myint != this-=>m_nCount)
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Instruction Recording

Instruction recording can be useful for detecting changes to
a known behavior; the point in execution (B) that diverges
from a previous execution(s) (A). The commands are:

. recStart - starts recording or starts comparing if a previous
recording exists

. recStop - ends recording
. recPause - pause recording
. recResume - resumes recording

The recStart command begins recording instructions.
Executed instructions are then stored. When a recStop
command is encountered, the recording is saved. There can
only be one saved recording at any one time between two
Actionpoints. When a recStart is encountered and a
previous recording exists, the debugger will begin
comparing each subsequent instruction with its recording. It
could perform many comparisons. If and when a difference
is detected, the debugger will break and the line of code
where the behavior changed will be displayed in the code
editor. The iteration of the comparison is also printed.

The recording is stored in memory by default, but it can also
be stored to a file with the command syntax:

recStart filesspec
For example:
recStart c:\mylogs\onclickbutton.dat
When a recStart command is encountered that specifies a
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file, and that file exists, it 1s loaded into memory and the
debugger will immediately enter comparison mode.

Expressions

There 1s no implicit precedence in Breakpoint, Actionpoint
and Testpoint conditional expressions. In complex
expressions, the use of parentheses 1s mandatory. See these
examples:

Type Example

Actionpoint = (#myint=1) AND (#mystr="Germany")
UDV

example

Local (this.m_nCount > 10) OR (nCount%]1)
variables (this.m_nCount > 10) OR (bForce)
examples

Equality <> - Not Equal

operators in I= - Not Equal

conditiqnal __ - Equal

expressions — - Equal

Assignment = - Assigns RHS to LHS
operator in

Actionpoint
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Arithmetic / - division
operators 1n + - plus
conqunal - - minus
expressions

* - multiplication
% - modulus

Logical AND - both must be true
operators in - OR - one must be true

conditional & & - both must be true

exXpressions
P || - one must be true

A - exclusive OR (only one must be true)
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View Variables in Other Scopes

Access

Ribbon

Other

Views

View

Watches

(c) Sparx Systems 2023

Execute > Windows > Watches

Execution Analyzer window toolbar :
# - | Watches

Description

The Watches window 1s most useful for
native code (C, C++, VB) where it can be
used to evaluate data items that are not
available as Local Variables - data items
with module or file scope and static Class
member items.

You can also use the window to evaluate
static Class member 1items in Java and
NET

To add a watch, type the name of the
variable to watch in the toolbar, and press
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the Enter key.

To examine a static Class member
variable in C++, Java or Microsoft .NET,
enter its fully qualified name:

CMyClass::MyStaticVar

To examine a C++ data symbol with
module or file scope, just enter its name.

Variables are evaluated by looking at the
current scope; that is, the module of the
current stack frame (you can change the
scope at a breakpoint by double-clicking
the frame in the Call Stack).

If the global variable exists in a different
module, you can examine the variable by
prefixing the module name to the variable

modulename!variable name

It 1s quite easy to mistype data item
names, so 1f you make or find an error,
highlight the string, press F2 and retype
the text. This also speeds up the
resolution of named items 1n the
debugger, by breaking a search when
matching item are discovered.

History The history of items entered is
maintained. Previously entered names or
expressions can be selected again using
the Up arrow key and Down arrow key
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inside the toolbar text box. The history
will also persist for the user across any
instance of Enterprise Architect or model
on the same machine.
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View Elements of Array

You can use the Watches window to inspect one or more
specific elements of an array.

In the field to the left of the Watches window toolbar, type
the variable name of the array followed by the start element
and the number of elements to display. The start element is
enclosed in square brackets and the count of elements is
enclosed in parentheses; that is:

variable[start element](count of elements)

For example, Points[3](2) displays the fourth and fifth
clements of the Points array, as illustrated.

Watches 1 =
Points[3](2) = m
Variable Value Type
=4 Points CPoint[100]
— s Points[3] CPoint
{ O tagPOINT
ey X 10 long
: ey 35 long
Sy Points[4] CPoint
-4 tagPOINT
ey X 45 long
ey 35 long
F 1] I
%% Watches \,_,J Locals Memory Viewer

If you entered Points[3] the Watches window would show
the third array element only.

Access
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Ribbon Execute > Windows > Watches
Other Execution Analyzer window toolbar :
# - | Watches
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View the Call Stack

The Call Stack window is used to display all currently
running threads in a process. It can be used to identify which
thread is operational, immediately before program failure
occurs.

When a Simulation is active, the Call Stack will show the
current execution context for the running simulation. This
will include a separate context stack for each concurrent
simulation 'thread'.

A stack trace 1s displayed whenever a thread 1s suspended,
through one of the step actions or through encountering a
breakpoint. The Call Stack window can record a history of
stack changes, and enables you to generate Sequence
diagrams from this history.

Access
Ribbon Execute > Windows > Call Stack
Other Execution Analyzer window toolbar :
# - | Call Stack
Use to

. View stack history to understand the execution of a
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process
. View threads
. Save a call stack for later use

. Record call stack changes for Sequence diagram
generation

. Generate a Sequence diagram from the call stack
. View the related code line in the Source Code Editor

Facilities
Facility Description
Indicators . A pink arrow highlights the current
stack frame
. A blue arrow indicates a thread that 1s
running
. A red arrow indicates a thread for
which a stack trace history is being
recorded
Save a Call Not currently available.
Stack to a
TXT File
Record a To record the execution of a thread and
Thread in a direct the recording to the Record &
Debug Analyze window, right-click on the
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Session thread in the Call Stack and select the
appropriate context menu option:

. 'Record' - to manually record the
current thread during the debug session
Used in conjunction with the 'step'
buttons of the debugger; each function
that 1s called due to a step command 1s
logged to the Record & Analyze
window

. 'Auto-Record' - to perform
auto-recording during a debug session
When you select this icon, the
Analyzer begins recording and does not
stop until either the program ends, you
stop the debugger or you click on the

'Stop' icon
Stop If you have started a manual or automatic
Recording recording of a thread you can stop it

before completion; select the thread
(indicated by a red arrow) and either:

. Click on the & (Stop Recording)
button in the toolbar or

. Right-click and select the 'Stop' option

Generate a To generate Sequence diagram from the
Sequence Call Stack trace, either:

Diagram . Click on the i (Generate Sequence
from the Call
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Stack Diagram of Stack) button, or

. Right-click and select the 'Generate
Sequence Diagram' option

Copy Stack To add the stack details immediately to
to Recording | the Record & Analyze window (for later
History generation of Sequence diagrams) either:

. Click on the (& button, or

. Right-click and select the 'Copy Stack
to Record History' option

Toggle Stack = To toggle between showing the full stack

Depth and showing only frames with source,
click on the = (Toggle Stack Depth)
button.

Display Double-click on a thread/frame to display

Related Code  the related line of code in the Source

1n Source Code Editor; local variables are also

Code Editor refreshed for the selected frame.
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Create Sequence Diagram of Call Stack

The Call Stack window records a history of stack changes
from which you can generate Sequence diagrams.

Access
Ribbon Execute > Windows > Call Stack
Other Execution Analyzer window toolbar :
i - | Call Stack
Use to

. Record Call Stack changes for Sequence diagram
generation

. Generate a Sequence diagram from the Call Stack

To generate a Sequence diagram from the current Stack,
click on the % (Generate Sequence Diagram of Stack)
button on the Call Stack window toolbar.

This immediately generates a Sequence diagram in the
Diagram View.
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Inspect Process Memory

Using the Memory Viewer, you can display the raw values
of memory in hex and ASCII. You can manually define the
memory address in the 'Address' field (top right), or
right-click on a variable in the Locals window or Watches
window and select the 'View Memory at Address' option.

Access
Ribbon Execute > Windows > Memory Viewer
Other Execution Analyzer window toolbar :
& - | Memory Viewer
From Locals window or Watches window
: Right-click on a variable | View
Memory at Address
Notes

. The Memory Viewer is available for debugging Microsoft
Native Code Applications (C, C++, VB) running on
Windows or within WINE on Linux
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Show Loaded Modules

For .NET and native Windows applications, you can list the
DLL's loaded by the debugged process, using the Modules
window. This list can also include associated symbolic files
(PDB files) used by the debugger.

Access

Ribbon Execute > Windows > Modules

Modules Window display

Column Description

Path Shows the file path of the loaded module.
Load Shows the base memory address of the
Address loaded module.

Modified Shows the local file date and the time the
Date module was modified.

Debug Shows:

Symbols . The debug symbols type
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Symbol File
Match

Symbol Path

Modified
Date
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. Whether debug information is present
in the module, and

. Whether line information is present for
the module (required for debugging)

Indicates the validity of the symbol file; 1f
the value 1s false, the symbol file 1s out of
date.

Shows the file path of the symbol file,
which must be present for debugging to
work.

Shows the local file date and time the
symbol file was created.
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Process First Chance Exceptions

Access
Ribbon Execute > Tools > Debugger > Process
First Chance Exceptions
Other Debug window toolbar : # */| Process

First Chance Exceptions

Processing Elements

Element Description
Debug When an application is being debugged
Process and the debugger is notified of an

exception, the application is paused and
the debugger responds in the way it is
configured to do; it either:

. Resumes the application and leaves the
exception to the application to manage,
or

. Keeps the application suspended and
passes the exception to the appropriate
routines for automatic resolution or
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manual intervention

Second The Enterprise Architect debugger
Chance defaults to the first listed behavior.

Exceptions If the application can handle the
exception, it continues to process; if it
cannot handle the exception, the
debugger 1s notified again and this time 1t
must suspend the application and resolve
the exception condition.

In this behavior, because the debugger
has encountered the exception twice, it 1s
known as a second-chance exception; in
this case, if the exception does not halt
execution, it 1s ignored and you avoid
spending time on conditions that do not
impact the overall outcome of processing.

Y ou might work this way on large or
complex systems that invariably involve
exception conditions somewhere in the
processing paths.

First Chance = However, if you want to examine every

Exceptions exception that occurs as soon as it occurs,
you can set the debugger to adopt the
second behavior.

Because the debugger responds to the
exception on first contact, it is known as
a first-chance exception.
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Y ou might work this way with individual
functions or routines that must work
cleanly or not at all.

Selection Select the 'Process First Chance
Exceptions' option to debug exceptions
on first contact.

Deselect the option to process exceptions
only if the application fails when they
occur.
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Just-in-time Debugger

You can register the Enterprise Architect debugger as the
operating system Just-in-time debugger, to be invoked when
an application running outside Enterprise Architect on the
system either encounters an exception or crashes. When you
do so, an application crash will cause Enterprise Architect to
be opened, and the source and reason for the crash
displayed.

Access

Ribbon Execute > Tools > Debugger > Set as JIT
Debugger

(c) Sparx Systems 2023 Page 226 of 237



Build and Debug 13 November, 2023

Services

Enterprise Architect provides two services to facilitate
remote script execution and remote debugging. The services
primarily support Enterprise Architect running on Linux to
allow users to run native Linux shell scripts and debug
Linux programs. The Satellite service supports Analyzer
Scripts while the Agent service supports debugging.

Access

Ribbon Execute > Tools > Services

The Satellite Service

The Satellite service is responsible for executing Analyzer
Scripts on the machine on which it 1s running. The feature
can help Linux users to execute native Linux programs and
shell commands directly, bypassing Wine. The service can
be managed from the ribbon, and it can also be run
independently from a terminal.

The Linux Shell

The default shell used by Enterprise Architect is 'bash'. To
override the Linux Shell used by Enterprise Architect, open
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a Linux terminal, run 'wine regedit ' and add a string value
to this registry key:

HKEY CURRENT USER\Software\Sparx
Systems\EA400\EA\Options

where:

. key name: "LINUX"

. key value: path

and path is the Linux path to the shell program "/bin/bash",

for example.
Permissions

Under Linux you must check that the service programs have
the appropriate permissions. The programs are located under
the Enterprise Architect installation folder, in the sub
directory "VEA/x86/linux'. Check that each of the programs
in this directory has the execute permission set for the
owner.

Notes

. The Satellite services are enabled in the Unified and
Ultimate Editions of Enterprise Architect

The Agent Service

The Agent service 1s responsible for managing debugging
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sessions for Enterprise Architect's GDB debugger. The
service allows Enterprise Architect users to debug Linux
programs. The service can be managed from the ribbon. It
can also be run independently from a terminal.

The Services Menu

Option Description

View Status | Displays a View that lists the status of

of all cach Enterprise Architect service named
Service(s) in the config file, and its state.

Satellite

Service

Start Starts the service. The service listens on

the Satellite Port configured in any
Analyzer Script Services Page.

Stop Stops the service.

Test Tests the status of the Satellite Service,
whether it is running or not.

Agent
Service
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Start Starts the service. The service listens on
the Agent Port configured in an Analyzer
Script Services Page.

Stop Stops the service.

Test Tests the status of the Agent Service,
whether 1t 1s running or not.

Code Miner
Service

Start This option reads the current Service
Configuration file and starts services that
are configured to run, and stops running
services that are not configured to run. A
service 1s configured if:

1. It 1s named in the config file.
2. It has the attribute status:ON.
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Start Services X
ON:EA port:9910, (Running)
Apply Close

Stop All This option stops any services that are

currently running.
Edit This option prompts for the Service
Configuratio = Configuration file to use, then opens that
n File file in an Enterprise Architect text editor.

The system remembers where the file is

held.

31# <number> - digiis

£ 72 - e

33#

34 {

35 name=projectl,

36 status=0N,

37 lazyload=true,

38 port=991@,

39 allow=localhost,

40 network=1local,

41 autoupdate=true,

42 show=true,

43 logoutput=c:\My Documents\projectl.txt,

44 loglevel=information|warning|error,

45 database=c:\My Documents\projectl\projectl.cdb

46}

47
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Auto Start This option automatically starts services
with EA having the 'status:ON' attribute when the

model opens.
System Output

System Debug Auditog Broadcast VClog Job History  Script 4

Full load on demand package: 1

EAQ00-0000-2F00

Auto Start Services Enabled

Service Configuration: C:\ea\intelservice\SparxServices.config
Service EA is running

The messages logged to the System
Output window here when the model is
opened indicate that the service was
already running.

Auto Stop on = This option automatically stops running
Close services when Enterprise Architect 1s
closed down.
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Analyzer Services Window

The Analyzer Services window displays the status of each
of:

. The services being managed by the active Analyzer Script
(maintained through the 'Execute > Tools > Analyzer'
ribbon option)

. Any local services managed separately using the service
configuration file (available from the 'Execute > Tools >
Services > Code Miner Service > Edit Configuration File'
ribbon option)

» v %

@Start Page E Analyzer Services o
Computer: SMEAGHER-2111 System: Linux Mint, 20.3 (Una)
EA: 16.0 Build 1602 Model: regression
Type 0/s Name Source Status

Sparx Linux Linux Satellite Service Analyzer Running Edit
Spanx Windows Windows Satellite Service Analyzer Running Edit

Remote Intel Service Analyzer Running Edit

The window lets you see at a glance which intel service you
are using, for example, or that the Windows service you use
to work in Enterprise Architect is running.

All of the data in the window is read-only, but you can edit
the service by clicking on the Edit button. This displays the
'Private Options - Services' page of the Analyzer Scripts
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Editor window, which you can update as required.

Access

Ribbon

Keyboard
Shortcuts

Execute > Tools > Services > View
Status of All Services

Start > All Windows > Execute >
Analyze | Analyzer Services

Alt+4 | Analyze | Analyzer Services

Analyzer Services Window Fields

Field

Computer

System

EA
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Description

The work station on which the services
are running.

The operating system under which the
work station 1s running.

The release number and build number of
the version of Enterprise Architect you
are using.
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Model

Type

O/S

Name

Source
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The name of the model in which you are
currently working.

The type of service. The services listed as
type 'Sparx' are Enterprise Architect
Services.

The operating system under which the
Service runs.

The name and description of the service.

. The Linux Satellite Service 1s managed
automatically by Enterprise Architect
when the application 1s running on
Linux under WINE

. The Windows Satellite Service is an
optional service that 1s typically used in
WINE installations to help build Visual
Studio Projects on a remote Windows
machine such as a VM (Virtual
Machine); the service only runs on
Windows and 1s managed locally using
Windows Services on the machine
itself

The script group or configuration file
defining the service.
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Status The status of the service.

When you first open the window, each
service 1nitially has the Status 'Test' as the
system assesses the service. The Status
then changes to the appropriate value,
such as 'Running' or 'Stopped'.

Edit Click on this button to view or edit the
service definition.
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